FLUID FLOW CHARACTERIZATION AND IN SILICO VALIDATION IN A
RAPID PROTOTYPED AORTIC ARCH MODEL

A Thesis
presented to
the Faculty of California Polytechnic State University,

San Luis Obispo

In Partial Fulfillment
of the Requirements for the Degree

Master of Science in Biomedical Engineering

by
Alexandra Knauer

September 2016



©2016

Alexandra Knauer

ALL RIGHTS RESERVED

i



COMMITTEE MEMBERSHIP

TITLE:

AUTHOR:

DATE SUBMITTED:

COMMITTE CHAIR:

COMMITTEE MEMBER:

COMMITTEE MEMBER:

Fluid Flow Characterization and In Silico
Validation in a Rapid Prototyped Aortic Arch
Model

Alexandra Knauer

September 2016

David Clague, Ph.D.
Professor of Biomedical Engineering

Cameron Purcell, M.S.
Senior R&D Engineer at Claret Medical

Lanny Griffin, Ph.D.
Professor of Biomedical & General Engineering

111



ABSTRACT

Fluid Flow Characterization and In Silico Validation in a
Rapid Prototyped Aortic Arch Model
Alexandra Knauer

Transcatheter aortic heart valve replacement (TAVR) is a procedure to replace a
failing aortic valve and is becoming the new standard of care for patients that are not
candidates for open-heart surgery [2]. However, this minimally invasive technique
has shown to cause ischemic brain lesions, or “silent infarcts”, in 90% of TAVR
patients, which can increase the patient’s risk for stroke by two to four times in future
years [3]. Claret Medical Inc., a medical device company, has developed a cerebral
protection system that filters and captures embolic debris released during
endovascular procedures, such as TAVR. This thesis utilized CT scans from Claret
Medical to create a physical construct of the aortic arch to experimentally validate a
theoretical computer model through flow visualization. The hypothesis was that the
empirical model can accurately mimic the fluid dynamic properties of the aortic arch
in order validate an in silico model using the finite elements program COMSOL
MultiPhysics® Modeling Software. The physical model was created from a patient
CT scan of the aortic arch using additive manufacturing (3D printing) and polymer
casting, resulting in the shape of the aortic arch within a transparent, silicone material.
Fluid was pumped through the model to visualize and quantify the velocity of the
fluid within the aortic arch. COMSOL MultiPhysics® was used to model the aortic
arch and obtain velocity measurements, which were statistically compared to the
velocity measurements from the physical model. There was no significant difference
between the values of the physical model and the computer model, confirming the
hypothesis. Overall, this study successfully used CT scans to create an anatomically
accurate physical model that was validated by a computer model using a novel
technique of flow visualization. As TAVR and similar procedures continue to
develop, the need for experimental evaluation and visualization of devices will
continue to grow, making this project relevant to many companies in the medical
device industry.

Keywords: Computer model validation, 3D printing, aortic arch, TAVR, transcatheter
aortic valve replacement, additive manufacturing, rapid prototyping, COMSOL
MultiPhysics®
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CHAPTER 1: INTRODUCTION

1.1 Purpose and Background

Every year, more than five million Americans are diagnosed with heart valve
disease, the most common affecting the aortic valves [1]. Transcatheter aortic heart valve
replacement (TAVR) is a procedure to replace a failing aortic valve and is becoming the
new standard of care for patients that are not candidates for open-heart surgery [2].
However, this minimally invasive technique has shown to cause ischemic brain lesions,
or “silent infarcts”, in 90% of TAVR patients. This can increase the patient’s risk for
stroke by two to four times in future years [3].

While TAVR is a minimally invasive procedure, the high risk of silent cerebral
lesions and the risk of stroke can be life threatening for a patient. Claret Medical Inc., a
medical device company, has developed a cerebral protection system that filters and
captures embolic debris released during endovascular procedures, such as TAVR. The
device is used globally, though is not yet commercially available in the United States [4].
Previous studies by Andrew Janicki (2015) used CT scans from Claret Medical to track
particulates within the aortic arch using COMSOL MultiPhysics®, a finite element
analysis computer-modeling program.

This project will utilize the same CT scans from Claret Medical to create a
physical construct. The goal is to create a construct that can be used to experimentally
validate the theoretical computer model through flow visualization. As TAVR and similar

procedures continue to develop, the need for experimental evaluation and visualization of



devices will continue to grow, making this project relevant to many companies in the

medical device industry.

1.2 General Approach

This study has three aspects: a physical model, a computer simulation, and flow
visualization experiments. The physical model of the aortic arch will be created from a
patient CT scan of the aortic arch. The CT scan will be converted to an STL file, 3D
printed, and cast with an optically clear rubber. This will create the shape of the aortic
arch within an enclosed, transparent material that can be used to visualize and
characterize the flow of fluid within the aortic arch.

The COMSOL MultiPhysics® model of the aortic arch, first evaluated by Janicki
(2015), will be modified to improve the model’s accuracy. Current modifications defined
by Janicki are improvement of the STL file and a change in the fluid viscosity within the
model. Additional modifications of the model will be defined through evaluation of the
previous work and further development of the project.

The final aspect of this thesis is flow visualization within a physical aortic arch
model. Fluid will be pumped in the physical model and dye will be injected and evaluated
to quantify the flow within the arch. The output of the flow within the physical model
will be compared to the output of the COMSOL MultiPhysics® model for statistical

significance.



1.3 Study Aims
The specific aims of this study are as follows:

1) To create a three-dimensional, physiologically accurate construct of the aortic
arch using additive manufacturing techniques for the purpose of clinical
testing.

1) To improve a predictive COMSOL MultiPhysics® model of blood flow
conditions within the aortic arch.

1i1) To validate a model in COMSOL MultiPhysics® model through comparison

to the fluid dynamics in an empirical model.

The hypothesis of this study is that the empirical model can accurately mimic the fluid
dynamic properties of the aortic arch found in the human body as well as validate an in
silico model using the finite elements program COMSOL MultiPhysics® Modeling

Software.



CHAPTER 2: BACKGROUND & RELATED STUDIES

2.1 Anatomy and Clinical Relevance

The aortic arch carries blood from the heart to the rest of the body, first branching
from the top of the arch. The most common anatomy of the aortic arch (Figure 1) has,
from left to right, the first branch of the innominate (or brachiocephalic) artery, the
second branch of the left carotid artery, and the third branch of the left subclavian artery.
With respect to Figure 1, blood travels from the heart on the left to the descending aorta

on the right or to the branching vessels [5].

Right Left
Carotid a. Carotid a.
Right / \ Left
Vertebral a. Vertebral a.

Left

Right Subclavian a.

Subclavian a.

Innominate a.

SMAYO

Figure 1. Typical aortic arch anatomy with branching arteries.

In this anatomy, blood that travels into the brachiocephalic artery bifurcates into the right
common carotid and the right subclavian arteries. The right subclavian flows into the arm
and the right common carotid flows into the cerebral circulatory system. Blood that

travels into the left common carotid artery flows into the cerebral circulatory system.
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Finally, the left subclavian artery bifurcates into the vertebral artery, leading to the
cerebral circulatory system, and the left subclavian artery [J].

The second most common pattern of human aortic arch anatomy is the “bovine
arch”, as shown in Figure 2. This arch anatomy has a common origin for the

brachiocephalic artery and the left common carotid artery.

Right Left
Carotid a. Carotid a.
Right / Left
Vertebral a. Vertebral a

Right Subclavian a.

Subclavian a.

Innominate a.

SMAYO

Figure 2. The "bovine arch" anatomy with innomipgte and left common carotid arteries with the same
origin.
Other variations of the aortic arch occur with different branching patterns and distances
between artery origins [5]. While there is no “standard arch”, the anatomy of the aortic
arch with three, distinct branching vessels is seen in about 70% of individuals [5, 6].
The aortic valve controls blood flow to the aortic arch; blood is pumped from the
lungs, to the left atria, to the left ventricle, through the aortic valve and into the aortic

arch. The valve, as seen in Figure 3, separates the heart from the aortic arch, and



subsequently the rest of the body. The purpose is to maintain one-way blood flow out of
the heart and into the aortic arch. The aortic valve opens when the left ventricle contracts
and closes when the left ventricle relaxes, obstructing blood from flowing back into the

heart [13].

Superior

Apex + Base X
Right

Inferior

ventricle

P |
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N r— 1
ﬁ‘\-‘; P

Figure 3. Anatomy of the heart with the aortic valve leading to the aortic arch.[7]

There are two main types of aortic valve disease that can affect blood flow
through the aortic valve: stenosis and regurgitation [8]. Stenosis is when the valve does
not open entirely and the blood is obstructed from leaving the heart [9]. Regurgitation is
when the valve does not close completely after blood is pumped out of the heart, allowing
blood to leak backwards. Both abnormalities can be congenital or acquired; patients are
either born with a valve abnormality, for instance with only two cusps instead of the
normal three, or the patient’s valve leaflets become calcified and develop scar tissue that

limits the opening and closing of the valve [9].



Patients with aortic valve disease show symptoms such as shortness of breath,
chest pain, dizziness, or loss of consciousness. The symptoms are due to the narrowed or
leaky valve causing improper blood flow. Left untreated, aortic valve disease can lead to
hypertrophy of the left ventricle and potentially sudden death [8, 9]. Symptomatic aortic
stenosis, if left untreated, has an annual mortality of 25% and an average survival rate of
2 to 3 years [10]. Currently, there is no medication that can cure aortic valve disease and
it is most often treated with surgery.

The three most common surgeries are aortic valve repair, surgical aortic valve
replacement, and transcatheter aortic valve replacement [8,10]. The risk factors affecting
a doctor’s surgical decision include the severity of the valve disease, age, general health,
and whether other heart surgery procedures are required for the patient at that time [11].
Repair of the aortic valve can be done by adding tissue to support the valve, removing or
reshaping tissue, or separating fused valves [11]. While valve repair is preferred, as it
preserves the function of the heart muscle, not all valves can be repaired, as is often the
case with the aortic valve [11]. Valve replacement requires replacing the aortic valve with
a man-made or biological valve through surgical aortic valve replacement or transcatheter
aortic valve replacement surgery.

Surgical aortic valve replacement (SAVR) is the most common treatment for
aortic valve disease and is an open-heart procedure. During the procedure, the surgeon
creates a 6- to 8- inch incision down the center of the sternum to remove and replace the
diseased valve [12,18]. The procedure typically takes a few hours and involves using a

heart-lung (bypass) machine through an incision in the chest.



Transcatheter aortic valve replacement (TAVR) is an alternative to SAVR and
currently indicated for patients that have high surgical risk and are not candidates for
open-heart surgery. Specifically, TAVR was developed for patients with severe
symptomatic aortic stenosis who have an unacceptably high estimated surgical risk [15].
The indication could expand to lower surgical risk patients in near future, although
SAVR is still the standard treatment of care for low risk patients [14]. Transcatheter
aortic valve replacement is less invasive and allows a new valve to be inserted within the
native, diseased aortic valve. It does not require a bypass machine and the surgery is
performed using a catheter through a small incision. The most common type of TAVR is
through transfemoral approach, using a small incision in the patient’s leg to access the
heart. The delivery system carries the valve to the heart and the aortic valve; when the
valve is expanded, typically through a balloon delivery system, the new valve is placed
over the diseased valve [16]. The valve is secured and immediately replaces the diseased

valve, as shown in the procedure outline in Figure 4.

Figure 4. The TAVR procedure outlined. A) The valve is inserted into the aortic valve through a catheter.
B) The balloon is expanded over the diseased valve. C) The new valve is expanded and placed over the
diseased valve.



2.2 Complications of TAVR

In recent studies, TAVR has shown safety, efficacy, and non-inferiority to
conventional surgical aortic valve replacement (SAVR). In a study published in 2012,
TAVR was shown to reduce the rates of death and hospitalization for patients that were
not candidates for surgery. Data from 2-year outcomes showed patients had a 25 percent
decrease in death from any cause, a 50 percent decrease in heart related death, and a
significant improvement in symptoms [18]. Currently, TAVR is approved in the United
States for extreme risk or inoperable patients. Trials are being conducted in Europe for
intermediate risk patients and initial results have shown equivalency to SAVR [19]. A
study published in 2016 compared TAVR to SAVR in a randomized study in lower-risk
patients with severe aortic valve stenosis. The reported two-year outcome showed TAVR
to be safe and effective for lower risk patients [20].

Though TAVR has shown to be beneficial for patients that are at high risk,
complications such as paravalvular leak and stroke risk have been associated with TAVR
in comparison to SAVR [20]. Specifically concerning stroke risk, randomized studies
have shown a significantly higher stroke rate after TAVR procedures as opposed to
SAVR [21]. For both procedures, strokes are considered to be embolic (as opposed to
ischaemic or haemorrhagic); the mechanism and risk occurs during the insertion of a new
valve. When the new valve is replacing the diseased or calcified valve, there is a risk of
material being dislodged and traveling to other parts of the body. This can include the
branching brachiocephalic and left carotid arteries on the aortic arch, leading to the

cerebral system and potentially causing stroke complications [22]. In the case of TAVR,



the calcified or diseased valve remains in the body and mechanism of the atheroemboli or
calcified material is thought to be during balloon predilation, valve positioning, or valve
implantation, mechanisms which are not present during SAVR [21,22].

While stroke rate is declining for TAVR as technology continues to improve, in
recent studies decreasing from 7 to 1.7-4.8%, the embolization of debris is still a concern
for TAVR procedures [21]. Silent cerebral lesions were detected in 68-93% after TAVR
and 38-54% after SAVR [21]. Silent cerebral lesions, or silent ischaemic infarctions, are
defined as brain lesions that are a result of a vascular occlusion and are often only
detected through magnetic resonance imaging (MRI) [23]. Unlike strokes, patients with
silent cerebral lesions do not show immediate symptoms. While data is varying regarding
the correlation between silent cerebral lesions and neurocognitive function [21], silent
cerebral lesions have been linked to progressive brain damage and as a precursor to
symptomatic strokes [23]. Due to the significantly high rate of silent cerebral lesions
complicating TAVR procedures, medical device companies have recognized these risks
and have developed cerebral protection systems. The purpose of these devices, such as
Claret Medical’s Sentinel Cerebral Protection System (CPS) is to reduce brain embolism

by filtering or deflecting debris [23].

2.3 Claret Medical’s Sentinel Cerebral Protection System

Claret Medical is a medical device company founded in 2009 and located in Santa
Rosa, California. The company has developed the Sentinel ™ Cerebral Protection System
(CPS) with the purpose of reducing stroke risk during interventional cardiology and

cardiovascular procedures. The device is indicated for TAVR procedures as well as in
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thoracic endovascular aneurysm repair (TEVAR), left atrial appendage occlusion
(LAAO), and transcatheter mitral valve replacement [24]. The Sentinel CPS is “the only
device designed to protect the brain from the risk of stroke by filtering, capturing, and
removing debris dislodged during certain interventional and surgical cardiovascular.”
[24] The Sentinel CPS is currently an investigational device in the United States and is
undergoing clinical trials.

The Sentinel CPS is comprised of two embolic filters made of polyurethane film
with laser-drilled holes, mounted on self-expanding nitinol loops, and delivered through a
catheter. The device is inserted through the radial artery in the right arm and the filters
are placed within the brachiocephalic artery and the left common carotid artery during

procedures, as shown in Figure 5.

Figure 5. Claret Medical Sentinel Cerebral Protection System is placed within the brachiocephalic artery
and the left common carotid artery. [25]

The filters collect any debris released during a procedure and prevent debris from
traveling through the brachiocephalic artery and the left common carotid, and

consequently the head and neck. The debris can include valve tissue, calcification, or
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thrombus that is dislodged at any point during the procedure. In the example of TAVR,
once the valve is placed and the procedure is completed, the filters and collected debris
are recaptured into the catheter and removed from the patient [26]. In initial clinical trials,
Claret has shown a 65% reduction in the total volume of new brain lesions and a 57%

reduction in the number of new brain lesions 7 days after the procedure [27].

2.4 CT Scans for Device Testing

A significant difference between procedures for the surgical aortic valve
replacement (SAVR) and transcatheter aortic valve replacement (TAVR) is in the
visualization of the patient’s anatomy. In SAVR, there is direct, open access to the
anatomy that allows for visual evaluation of the aortic arch and aortic valve. TAVR lacks
open access and requires different methods of visualization during the procedure.
Techniques such as echocardiography, computed tomography, and fluoroscopy are used
to understand the aortic geometry for device selection and placement [28].

Prior to TAVR, patients undergo assessment of the aortic root anatomy and the
coronary and iliofemoral arteries to evaluate the feasibility of the procedure [29]. The
diagnostics include echocardiography, cardiac catheterization, aortioilliac angiography,
transcatheter heart valve sizing, and computed tomography (CT) scans [29]. Of those
methods, CT scans have been increasingly recognized as an optimal method to address
the evaluation of the surgical geometries and image for TAVR.

Due to varying anatomies, TAVR must be individualized for a patient [29]. For
example, the sizing of the catheter for transfemoral access is key to the success of the

procedure. As shown in Figure 6 of a CT angiographic image, the image reveals an area
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in the right external iliac artery that would inhibit endovascular access, as indicated by

the arrow.

Figure 6. CT angiographic image showing the right external iliac artery (arrow) that would inhibit
endovascular access. [30]

In this example, the patient would not be a likely candidate for transfemoral TAVR as the
patient’s femoral artery could be incompatible with a femoral catheter. This does not
necessarily disqualify a patient from TAVR, but is a risk factor that needs to be taken into
consideration.

Conventional angiography allows for basic assessment of the luminal size, though

it is not suitable for morphologic features. CT is considered a valuable tool to determine
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the presence and amount of anomalies such as atherosclerotic calcifications and can
determine patient eligibility, access strategy, and prosthetic valve selection [29].

While CT scans are useful for initial analysis, this method of imaging can be
further applied to three-dimensional analysis by converting the file. Programs such as
Mimics and OsiriX, can convert the CT scan into a different file format that is compatible
with computer-aided design (CAD) programs. A common application is the conversion of
a CT scan to a stereolithography (STL) file, which is a triangulated representation of a
three-dimensional object’s surface [31]. The file format is widely compatible with
programs related to CAD, rapid prototyping, and 3D printing. By converting a CT scan
into an STL file, or similar file format, the patient’s anatomy can be analyzed in a variety
of programs and is available for more applications, such as 3D printing and creating

models for physicians to visualize patient anatomy.

2.5 Existing Vascular Constructs and 3D Printing in Clinical Applications

Physical models are widely used in the biomedical field for applications from
physician training to marketing, to device testing. Vendors such as Elastrat, United
Biologic Silicone Vasculature, and DialAct Corporation manufacture anatomical models
based on engineering approximation, CAD files, or patient specific data [32,33,34].
While these models are widely used, rapid prototyping is a popular as a method of
prototyping models and visualizing patient anatomy.

The fundamental purpose of 3D printing is to create a rapid prototype of a model
through additive manufacturing. Fused Deposition Modeling (FDM) was originally

developed by Statasys and has become one of the most popular rapid prototyping
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techniques [35]. FDM works by horizontally depositing molten thermoplastic material,
extruded from a nozzle. The material is deposited layer-by-layer based on a 3D CAD data

file, filling each layer of the object (Figure 7).

Filament

Filament Pulling
System

<«—Heated Liquifier

Figure 7. Diagram of FDM rapid prototyping.

The liquefied filament cools after being laid down prior to the nozzle depositing the
following layer of filament. The nozzle also contains a second filament that provides
support material for the cooling filament, for features such as overhangs, which is
removed after printing. A limitation of FDM is that it has a rough finish and often the
ridges between layers of plastic are visible on the part. Additionally, in a medical
application the material is rigid does not mimic the properties of biological tissue [36].
However, a significant benefit of FDM is the ability to quickly print models at a
reasonable price from CAD software without additional manufacturing techniques. For

that reasons, among others, 3D printing has been applied within the medical field.
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At the Texas Cardiac Arrhythmia Institute, 3D printing was used to recreate
models of patient’s hearts before performing surgery [37]. The Institute acquired CT
scans of the patient’s heart and used 3D printing to create transparent models that allowed
doctors and patients to view internal structures when preparing for a procedure. The
models were prepared within hours and produced unique patient models to “provide
customized solutions for improving outcomes [37].”

Another example was in a study that created personalized brain models. Using 3D
printing, molding, and casting, the study created a physiologically, anatomically, and
tactilely realistic model based on magnetic resonance images (MRIs) [38]. The models
were used to improve surgical training and preoperative planning with the goal of
providing accurate, customized, high-precision treatment.

Similar examples exist within the hepatic system, gastrointestinal system,
musculoskeletal surgeries, and the vascular system [36]. Many hospitals are purchasing
in-house 3D printers for the purpose of planning complicated procedures, clinical
training, patient education, and creating customized prosthesis [36]. The prevalence and
growing popularity of additive manufacturing is applicable to minimally invasive
procedures, such as TAVR, as the models provide visualization of the anatomy. Within
biomedical engineering, 3D printing has been used to manufacture products as well as
test existing products. Models based on patient anatomy have been used in bench top
testing to develop medical devices and provide safety and efficacy data when applying
for approval from the FDA. Specifically, the models are used to optimize product design,
simulate various clinical anatomies, verify the utility of the technology, and perform wear

testing [39].
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2.6 Previous COMSOL MultiPhysics® Modeling Studies

COMSOL MultiPhysics® is finite element analysis (FEA) software suite that can
simulate fluid flow, particle tracking, and mechanical stresses. The COMSOL
MultiPhysics® model of the aortic arch was first evaluated by Andrew Janicki (2015),
using CT scans and project input from Claret Medical. As this thesis project builds on
Janicki’s previous work, this section will summarize the past study. Janicki’s study
additionally built off of thesis studies performed by Ian A. Carr and Shawn Shadden, who
analyzed the effect of particle size and the path of travel in the aortic arch using
computational fluid models.

The purpose of Janicki’s study was to track particles within the aortic arch and
determine what parameters cause the particles to enter the different branching vessels on
the aortic arch. The parameters evaluated were particle diameter, particle density, blood
pressure, and the diameter of the catheter used during TAVR procedures. By using finite
element analysis in COMSOL MultiPhysics®, Janicki determined that the diameter of the
catheter was not statistically significant. Additionally, larger particles have a higher
probability of entering the brachiocephalic artery, the left common carotid artery, and the
left subclavian artery, while smaller particles would continue in the descending aorta.

Averaging all particle diameters, densities, and blood pressure outcomes, Janicki
determined that 54.95 £ 13.66% of the 1,000 particles released would travel into the

cerebral circulatory system within his model.
Janicki’s COMSOL MultiPhysics® model used the Creeping Flow module and
had nine simulations run for 13 seconds with 0.5-second time steps. The results were
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analyzed using multivariate analysis of variance in JMP Pro 11 statistical software. The
study used the same CT scan, provided as a stereolithography (STL) file. The original file
with truncated daughter vessels, as seen in Figure 8, had 61,543 faces within the mesh

file.

Figure 8. Original STL file of the aortic arch with 61,543 faces.

Janicki used MeshMixer to simplify the model to 251 faces, as seen in Figure 9. The

geometry, while usable in SolidWorks, was an oversimplification of the original CT scan.
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Figure 9. The STL file modified on MeshMixer to 251 faces.

While the general shape of the arch remained intact and it reduced computational time,
the significant reduction of faces caused the model to have sharp sections that are not
anatomically accurate. This study will re-process the original STL file to have it be more
anatomically accurate as well as compatible with COMSOL MultiPhysics® and
SolidWorks.

David Baik, an undergraduate in the Cal Poly BioFluidics Lab, evaluated creep
flow and laminar flow within the aortic arch as a part of this thesis study. Creep flow
versus laminar flow is determined by a fluid’s Reynolds’s number. The Reynold’s

number describes the ratio of inertial to viscous forces with Equation 1 [40].

Equation 1: Re = %

Where p is the density, U is the characteristic velocity, d is the vessel diameter, and y is
the dynamic viscosity. At higher Reynold’s numbers both inertial forces and the Laminar
Flow module should be used on COMSOL MultiPhysics®; however, Janicki’s (2015)

model utilized the Creeping Flow interface, assuming a low Reynold’s number
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accounting only for viscous forces. In contrast, in Baik’s studies it was determined that
both inertial and viscous forces were present and that laminar flow is optimal for future
studies.

In relation to the current study, Baik and Janicki’s findings are relevant as the
results use the same original CT scan and concern the development of test methods for
procedures such as TAVR. Therefore, this study will improve the mesh size and use

laminar flow.
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CHAPTER 3: MODEL DESIGN AND METHODS

3.1 Model Geometry

The geometry of this model is based on a CT scan obtained from Claret Medical.
The scan is from a patient that underwent TAVR surgery with Claret’s Sentinel CPS
device. Therefore, the file used to create this model (physical and COMSOL
MultiPhysics® models) is from a real patient anatomy. This file was chosen for it’s
anatomical simplicity and since it has the most common anatomy of the aortic arch. The
CT scan from the patient was converted to a stereolithography (STL) file by an external

company for Claret Medical.

3.1.1 STL Processing
The file was processed using MeshMixer to reduce the number of faces on the
model and reduce anomalies along the arch. When opened in MeshMixer, the original

CT scan had 54,190 triangles within the mesh, as shown in Figure 10.

Figure 10. Original CT scan opened in MeshMixer with 54,190 triangles.
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While the high number of faces allows the computer to accurately represent the
biological model, it creates a complexity to that increases computational time and can be
incompatible with computer programs. Additionally, the high number of faces in the
original model was not necessary to represent the critical features of the model. By
simplifying the geometry, it reduced the computational time and made it possible to
import the model into SolidWorks and COMSOL MultiPhysics®.

The file was imported into MeshMixer and processed to reduce the number of
faces, as seen in Appendix A written by Brandon Cohen. The processing focused on
removing extraneous aspects of the arch that were not pertinent to fluid flow within the
arch. The number of faces was reduced to 9,488 faces, as seen in Figure 11, and the file

type was converted to be compatible with SolidWorks.

Figure 11. Modified STL file of the aortic arch with 9,488 faces.

3.2 Physical Model Design Concept
The physical model utilized the modified STL file with 9,488 faces. The goal was

to create a transparent model of the aortic arch in order to visualize fluid flow. The
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material selected for the model was polydimethylsiloxane (PDMS), since it is translucent
and has the ability to capture features at the microscopic level. The material is commonly
used in the manufacturing of microfluidic chips. As seen in Figure 12, models are
typically made with PDMS by having a master mold, pouring PDMS over the mold, and

then removing the PDMS containing a negative of the master mold.

PDMS pouring Release of

Mast Id : ; [
ASIErMOE " & reticulation  PDMS replica

Figure 12. An overview of microfluidics manufacturing methods. 1) A master mold exisits with the shape.
2) PDMS is poured over the master mold. 3) The PDMS is removed from the master mold, leaving a cavity
in the shape of the master mold. [41]

The physical model of the aortic arch utilizes a similar molding process.

However, unlike microfabrication, the aortic arch geometry contains daughter vessels and
is non-symmetrical, making the release of the PDMS negative a challenge. In order to
create a negative of the aortic arch, a process was developed that allowed the master mold
to be removed without damaging the PDMS or altering the shape of the vasculature.

In a previous thesis project by Daniel Greinke, a dissolvable polymer was cast
within PDMS to evaluate an iliac aneurysm. The study 3D printed the entire aneurysm
using water-soluble polyvinyl alcohol (PVA) filament. The full aneurysm model involved
the following steps (as seen in Figure 13): a triangular box was created using acrylic, blue

painter’s tape, and caulk to encase the aneurysm. One kilogram of PDMS was poured
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into the box and the 3D printed part of PLA was floated on top. The PDMS was allowed
to set before the remainder of the 3D printed part was covered in 1 kg of PDMS and the
entire model was set. Excess material was cut away from the outlets and the model was

submerged in hot water with the intention of dissolving the PLA.

a) Aneurysm Model PVC d)
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Figure 13. An overview of Greinke’s PDMS full mold process. A) the mold is assembled. B) Half of the
PDMS is poured into the mold and the aneurysm is allowed to “float” on top. C) The remainder of the
PDMS is poured over the aneurysm. D) The PDMS is allowed to set. E) Excess material is removed. F)
The aneurysm is submerged in water. G) The water is heated to dissolve the PVA. Source: Greinke

Although the model was submerged in hot water for 6 to 8 hours, it was
ineffective to completely dissolve the PLA. The model was also submerged for 14 days
in water that was periodically reheated to 120°F. However, regardless of the water
temperature and the amount of time the model was submerged, the PLA did not dissolve.
As seen in Figure 14, the study was unable to obtain a cavity in the shape of the

vasculature. The study ceased using the full aneurysm model for their experiments.
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Figure 14. Greinke’s full vessel construct of an iliac aneurysm after being submerged in hot water. The
PVA did not dissolve from the PDMS and material remained in the construct.

Despite the previous study not achieving a full vascular model, the study showed
that PDMS is an optimal material for its ease of use and the clarity for flow visualization.
For this study, the material needed to be transparent and semi-flexible, yet durable
enough to withstand the flow visualization tests. Other silicone-based materials were
considered, including Reynold’s Materials SORTA CLEAR series, SmoothOn Clear Flex
30 or 50, and SmoothOn Ecoflex. While these materials were feasible, PDMS (Sylgard
184 Silicone Elastomer Kit) was chosen for the model due to Greinke’s success in having
a transparent model, the ease of use, and material cost. However, a different method of
creating a 3D printed model will be used in this study.

The construction concept is based on having two half constructs bonded together
to create a cavity of the arch within a transparent material. The construction had the
following process (see the following sections for additional detail):

1) The CT/STL file was simplified in Mesh Mixer and saved as an STL
2) The arch was imported into SolidWorks and split into two halves

3) Each half was used to create a box mold within SolidWorks with alignment pins
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4) The two box halves were 3D printed

5) Each half was coated with Reynold’s Advanced Materials XTC-3D

6) PDMS was mixed and poured into each box

7) The PDMS castings were removed from the 3D printed boxes

8) A thin layer of PDMS was used to bond the two halves of PDMS

9) PDMS was removed from the inlets and outlets of the bonded PDMS halves

10) Tubing and adaptors were press fit into the inlets and outlets of the arch

3.2.1 Proof of Concept Prototyping

The concept was to create two half vessels and bond the halves together to create
a full model of the aortic arch. This method eliminates the need to dissolve PLA and
build an acrylic box as a mold. Also, this concept allows for the addition of alignment
pins and guarantee that the dimensions of each mold half are equivalent.

Proof of concept prototyping was done using a 3D printed 1-inch cube filled with

PDMS and with a cylinder through the middle, as seen in Figure 15.

Figure 15. Proof of concept prototyping of the 3D printed mold.
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The cylinder was created to test the ability to demold the vessels when using PDMS
when it is poured directly into the mold. The cube also tested the Reynold’s Advanced
Materials XTC-3D coating; the coating was applied to the cube’s surface and allowed to
dry for 24 hours. The purpose of the coating was to smooth the step sizes between the 3D
printed layers. (Refer to section 3.2.2 for more detailed descriptions of PDMS mixing and
coating application.)

The casting of the cube was removed from the mold using a chisel and hammer to
break the mold open. The cylinder was cut at one end of the cube and slid out through the

opposite end. As seen in Figure 16, the proof of concept was successful.

Figure 16. Proof of concept PDMS cube with cylindrical cavity.

The cube was transparent, maintained the cylindrical and cube shape without apparent
damage, and the layer lines were reduced without residue from the XTC-3D coating. For
these reasons, the 3D printed box concept was applied to the STL file of the aortic arch.
The proof of concept cube was also used to assess different bonding techniques
for PDMS to PDMS. In microfabrication, plasma bonding is used to bond PDMS to
glass. While the author tested this concept, a study by Eddings et al also showed that
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using uncured PDMS adhesive demonstrated an improvement in bond strength and
consistency when compared to oxygen plasma bonding for PDMS to PDMS bonding
[42]. Based on this study and prototype testing, uncured PDMS was determined to be the

optimal method to bond the PDMS halves.

3.2.2 SolidWorks Design and 3D Printing

The arch was imported into SolidWorks and split lengthwise into Part A and Part
B by inserting a plane and using the Split function. As seen in Figure 17, the green Part A
and the blue Part B split created two pieces without any detached segments. Each arch

half was designated as a separate part within SolidWorks.

Figure 17. The aortic arch file split lengthwise into Part A (green) and Part B (blue).
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The split plane was used to create a 1/4 inch base plane under each part. A box
was drawn from that plane and alignment pins with alternating directions were drawn for
Part A and Part B. The alignment markers for Part A and Part B were created to be
complimentary, making it possible for the halves to interact and align correctly. As seen
in the sequence of Figure 18, Part A was drawn to have outward pegs on the 3D printed

part.

Figure 18. The sequence of creating the 3D printed box with alignment pins for Part A in SolidWorks.

The box was created to maximize the build space of the 6 by 6” 3D printer as well and
fully enclose the arch halved. Part B, as seen in Figure 19, was created with the same
method but with inward alignment pins. The alignment pin was created with a slight

detent for mold removal purposes.
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Figure 19. Part B of the aortic arch with inward alignment pins.

For Part A, the brachiocephalic artery did not reach the edge of the box. Since the box is
being used as a mold, the vessel was extended with an added cylinder in SolidWorks so

the future cavity would have an outlet, as seen in Figure 20.

Figure 20. The added cylinder to Part A to allow the brachiocephalic artery to extend to the edge of the 3D
printed box.
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As previously mentioned, the two halves were drawn to interact. As shown in Figure 21,
Part A and Part B are complimentary and have the same dimensions for the box and the

alignment pins.

Figure 21. The interaction of Part A and Part B in SolidWorks.
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Dylan Sigley, a Cal Poly student that privately owns a 3D printer, printed the parts. The
printer is a Printrbot Simple Metal with a 6 inch by 6 inch build space that prints using an
additive manufacturing technique with PLA. The program Cura 15.04.6 was used to slide
the models and generate the code to print the model. Figure 17 shows Part A (left) and
Part B (right), unaltered after being 3D printed. Part A took 17 hours and 9 minutes to
print, taking 75.98 meters of filament (or 226 grams). Part A had a build failure towards
the end of the build, causing the box to be a 1/2-inch shorter than intended. However, it
did not affect the structure of the aortic arch. Part B took 15 hours and 33 minutes to print
and took 70.99 meters of PLA filament (or 212 grams). Refer to Appendix B for specific

printer basic and advanced settings.
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Figure 22. 3D printed boxes of Part A and B.

The inner portion of both parts (the area within the box containing the aortic arch) was
coated with two layers of Reynold’s Advanced Materials XTC-3D with a paintbrush. The
coating is intended to be a protective coating for smoothing and finishing 3D parts. The
coating was mixed by volume with a 2A:1B ratio with 20 milliliters of A and 1 milliliter

of B. The first layer was allowed to dry 24 hours before applying the second. As seen in
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Figure 23, the coating made the 3D printed parts appear shiny and filled space between

the different layers of material.

Figure 23. 3D printed boxes of Part A (left) and Part B (right) with Reynold's Advanced Materials XTC-3D
coating. Part A has an extension piece taped to the top of the box.

Since Part A had a build failure that caused the box to be shorter than intended, a 1/2”
extension piece was printed and taped to the top of Part A. The piece had the same width,
length, and thickness as the Part A box, but was only a 1/2” in height. It was superglued
and then duct taped to extend the height of the Part A box to original height created in
SolidWorks. The extension piece was necessary for the mold to have the correct volume

to contain the PDMS.

3.2.3 PDMS and Demolding
The polydimethysiloxane (PDMS) used was the Sylgard 184 Silicone Elastomer
Kit from Dow Corning. The volume of PDMS needed for Part A and Part B was

calculated using the inner dimensions of the boxes in SolidWorks. The calculated volume
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was then used to determine the volume needed for a 10A:1B ratio for the PDMS, using
10 parts of the base material and 1 part of the curing agent material. While the calculated
volume proved to be a larger volume than needed, as shown in Table 1, it served as an

initial baseline to predict how much material to purchase.

Table 1. PDMS Volumes Calculated and PDMS Volumes Used

Part A Part B
Total PDMS Volume (ml) 1208.94 1051.25
PDMS Base (ml) 1090 955
PDMS Curing Agent (ml) 110 95
Total Base Used (ml) 885 675
Total Curing Agent Used (ml) 89 68

The discrepancy between the calculated volume and the volume used for the model is due
to the volume of the aortic arch. The volume of the arch was not taken into account
during these calculations since the author intended to acquire and mix extra PDMS. This
proved to be necessary as 900 milliliters of PDMS were lost when a cracked beaker
shattered during degassing of the PDMS and the material was not usable. Therefore,
calculating and purchasing extra PDMS was necessary in creating this model.

With the exception of material volumes, the process of mixing and pouring for Part A and
Part B were identical. The PDMS was measured in glass beakers and mixed for 10
minutes with a paint stick. A vacuum (Figure 24) was using to de-gas the PDMS for 2
hours. (Due to the high volume of PDMS, the de-gassing took longer than expected.

Additionally, after the process the author discovered a valve that had not been closed that
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would have decreased the degassing time.) Meanwhile, Part A and Part B were prepared

by pressing Scotch tape on all parts to remove dust and debris from the molds.

Figure 24. The vacuum used to degas PDMS and remove bubbles.

The purpose of degassing was to remove all oxygen bubbles from the PDMS prior to
pouring to ensure the material cures translucent. Once the bubbles were no longer visible,
the PDMS was slowly poured into Part A and Part B. The parts were allowed to cure for

72 hours at room temperature (Figure 25).
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Figure 25. Part A (left) and Part B (right) with curing PDMS.

After the PDMS had cured, the models were demolded. Unfortunately, demolding was a
destructive process; a hammer and chisel were used to break the mold surrounding the

PDMS and remove the arch halves (Figure 26).

Figure 26. The removal of the PDMS from the 3D printed molds.

The removal of the PDMS from the molds took about two hours. A segment of the arch
on Part A ripped while it was being demolded (Figure 27) and was mended with PDMS
between the segments and allowed to dry 24 hours.
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Figure 27. The ripped section of Part A.

After the halves had been demolded and the rip was repaired, the alignment pins were
tested and proved to be successful. The two halves of the arch had the same outer
dimensions, allowing the two halves of the arch to align correctly. The two halves of the

PDMS casting can be seen in Figure 28.

Figure 28. The PDMS casting of the 3D printed parts with Part A (Ieft) and Part B (right).
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The halves were bonded together using 10 milliliters of base and 1 milliliter of curing
agent. The materials were mixed for five minutes, degassed for five minutes, and applied
to the surfaces of both halves in a thin film. The halves were pressed together and
aligned, using force distributed evenly on the top surface, as seen in Figure 29. The

weight applied was approximately 10 Ibs.

Figure 29. The halves were bonded by PDMS with applied weight.

Once weight was applied, the model was visually inspected for PDMS leaking into the
aortic arch cavity. The bonding PDMS was allowed to dry for 48 hours before the weight

was removed.

3.3 Flow Visualization Set-Up
For this study, steady-state flow was used to simulate the pumping of blood from

the heart. While the heart is pulsatile, pulsatile flow was beyond the scope of this study.
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From a study by Spodick et al, the average resting heart rate of a person is between 50
and 90 beats per minute, via [44]. The normal stroke volume in the human heart is 70
mL/beat. Therefore, the cardiac output through the aortic arch can be found for this range
of normal beats per minute (Equation 3). Cardiac output is given in mL/min, so this is
converted into US Gallons/min in order to find the correct pump to be used (as seen in

the conversion in Equation 3).

Equation2:  CO = SVXHR

Equation 3: 1 mL/min = 0.0158503 Gallons/min

From these calculations, the suitable rate for a pump to be used to simulate the heart is
between 55 to 100 Gallons/hour. A TotalPond Submersible Fountain Pump was chosen
as it can reach a rate of 102 Gallons/hour when run through 5 feet of tubing and was
within the project’s budget. The pump has a /2" outlet, therefore tubing with a ’2” inner
diameter was used for the model.

To connect the pump to the arch construct, a razor blade was used to remove
PDMS from the model to create a '% inch inlet of the model. A Y2 inch male adapter with
barbed tubing was then twisted and screwed into the inlet of the aorta. Once placed into
the arch, the fitting was then adhered to the PDMS with clear silicone caulking. In
addition to a barbed fitting placed at the inlet, a section of tubing was placed into the
outlet of the arch to help direct flow at the outlet of the arch. The construct with the inlet

adaptor and outlet tubing is shown in Figure 30.
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Figure 30. Physical model with an inlet adaptor and outlet tubing.

The daughter vessels had 3/8” and 2" tubing press fit into each, according to size,
to drain the aortic arch at the outlets. The entire PDMS construct was placed on a piece of
acrylic.

The insertion of the 2" adaptor showed to be detrimental to the model, as the
space in the PDMS was not large enough for the adaptor and caused the two halves to
begin to peal apart. Applying pressure with a C-Clamp, as seen in Figure 31, mitigated

this problem.
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Figure 31. The halves of the construct became unattached with the addition of adaptor (left) and were fixed
by applying pressure with a C-Clamp (right).

The model was placed on clear acrylic and elevated (using two 2 foot tall buckets) over a
light source. The light was placed underneath to properly illuminate the arch for imaging.
All imaging was done using an iPhone 6, placed over the set-up with a metal stand and
another piece of clear acrylic. The pump was submerged at the bottom of a bucket filled

with water. A side view and top view of the set-up are shown in Figure 32.
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Figure 32. The flow visualization set-up side view (left) and top view (right).

However, when the pump was plugged in and water was run through the arch, the
flow was extremely turbulent. Air bubbles were present throughout the arch and could
not be removed regardless of tube length or pump settings. Red food coloring were
injected at the inlet of the pump to better visualize the flow within the arch, as seen in

Figure 33.
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Figure 33. Turbulent flow with physiologic conditions within the aortic arch. Red food coloring was used
to better visualize the fluid flow.

Two methods were used to improve the fluid flow. First, a second pump was
purchased for slower fluid flow. The X-Small TotalPond Submersible Fountain Pump
pumps 70 gallons per hour at 1.5 feet of tubing. This slower flow rate is still within the
range of the average adult stroke rate of the heart. Second, the arch had an inlet and
maximum diameter of 1 inch; therefore, the 42" male inlet was removed and 1 inch tubing
was press fit into the model. Additional adaptors and tubing were purchased to attach the
1 inch inlet of the arch to the ' inch outlet of the pump. However, while these
modifications eliminated the turbulent flow, an air bubble was still present to the right of

the branching vessels (Figure 34).
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Figure 34. Fluid flow within the arch with red food coloring. A bubble is present to the right of the
branching vessels with the slower fluid flow, as indicated by the black box.

The larger inlet eliminated the majority of the air within the cavity of the arch,
however the loss of fluid from the outlet of the daughter vessels caused a bubble. At a
stationary and horizontal orientation, the fluid within the arch was not sufficient to fill the
entire diameter.

The bubble was removed by allowing the fluid to fill the arch, plugging the
outlets of the branching vessels, and inverted the model with the branches plugged. This
allowed the bubble to flow up the tubing and stay at the connection between the 1”” and
%" tubing. This method made it impossible to use outlet tubing and the set-up of the

experiment had to be altered. The arch was placed on plastic sheeting and placed over a
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bucket. This allowed the author to tilt the arch and still contain the liquid to a small area.

The arch was illuminated using headlamps, sealed in Ziplock bags, within the bucket.

The altered, finalized set-up is shown in Figure 35.

Figure 35. The finalized flow visualization set-up side view (left) and top view (right).

This method was not consistent, as sometimes the bubble would dislodge itself and travel
back into the arch. In these instances, the arch was inverted again before injecting dye.
The two set-ups were qualitatively compared for lighting within the arch, as seen

in Figure 36.
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Figure 36. The original arch set-up (left) and the finalized arch set-up (right).

There was not an improvement in lighting and arch visualization between the original set-
up (left) and the finalized set-up (right). However, the modified set-up allowed the bubble
to be removed and was adequate for image analysis. Lighting should be improved in

future studies.

3.3.1 Flow Visualization Trial Methods

For each trial, the pump was submerged in a gallon of water and water was
flowed through the arch. Once flow was established in the model, the bubble was
removed by plugging and inverting the arch model over the bucket. The arch model was
returned to a horizontal position and checked for bubbles. An iPhone 6 on “SLO-MO”
mode was used to record a video of the fluid flow. After the bubble was removed and
steady flow was established within the model, the iPhone was set to record and 3

milliliters of red food dye (Liquid Color Cherry Red Shade, Esco Foods Inc.) was
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injected towards the inlet of the pump. The general flow of dye can be seen in

screenshots of the video in Figure 36.

Figure 37. An example of the flow of dye through the aortic arch model.

The flow rate of the pump was measured at the same height and the same tube
length as used within the arch. It was assumed that the inlet of the vessel has the same
flow rate as the outlet of the tubing. Ten trials were conducted to measure how much time
it takes to fill 1 Liter using the pump, with an average of 13.74 seconds per liter. The inlet
velocity was calculated using the 1 inch cross section of the inlet, as seen in Appendix C.
The outlet velocity of the pump and inlet velocity of the model is 0.1436 meters per

second.

3.3.2 Flow Visualization ImageJ Methods
The videos from the flow visualization trials were opened in QuickTime 7.2 at
half size. The video was converted from seconds to frames, each frame representing an

average of 0.034 seconds per frame. (This value was calculated by taking the average of
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seconds per video divided by frames per video.) Screenshots were taken from the videos
every 10 frames (every 0.03 seconds) from the instance of the dye initially entering the
arch to when the dye filled the arch.

Each trial was individually imported into ImageJ, an open source image
processing and analysis software. As shown in Appendix D, the images were converted
into stacks and a color threshold was set at 130 saturation. Setting a color threshold added
consistent contrast to the image to determine how far the dye had traveled within the
arch. The author chose a saturation of 130 as the value selected the majority of the dye
within the arch and was then applied across all trials for consistency. Some erroneous red
pixels outside of the arch are visible in some images, as seen in Figure 37, and are due to
the orange bucket used to catch the water and dye. An example of a trial that had the

threshold applied can be seen in Appendix E.

Figure 38. The dye within the arch that was set with a color threshold in ImageJ. The threshold was also
applied to the bucket due to the orange color.
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The red threshold that was not within the arch is not considered dye movement for this
study and is assumed to be the orange bucket or orange reflection. After the color
threshold, the images were converted from a stack into individual images and saved for

analysis.

3.3.3 Flow Visualization Analysis Methods
The still images, processed in ImagelJ, were used to determine the coordinates of
the dye front. The coordinates were determined with the following method, which was
applied to every image of each trial:
1) Determine an origin (common feature) in COMSOL MultiPhysics® and ImageJ
2) Find the absolute distance from the origin in x and y coordinates
3) Convert the distance from pixels to meters
4) Find the coordinates of the common feature in COMSOL MultiPhysics®
5) Calculate the velocity between dye front locations
6) Measure the angle of rotation within ImageJ
7) Apply the coordinate transformation equations to find COMSOL MultiPhysics®
equivalent coordinates
The method was adapted from a procedure developed by Daniel Greinke (2015) and
Rachel Willis (2016); the velocity and position of the dye front was determined by
comparing the furthest downstream pixel value to the furthest downstream pixel value on

the proceeding frame.
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The origin was identified as the intersection of the left subclavian artery and the
aortic arch, as this location could be easily identified in both the physical and computer
models. The coordinates of that location were identified in COMSOL MultiPhysics® as
X, ¥y, and z coordinates. This origin point was used to align the coordinate systems and as
point of reference for the physical model.

The flow visualization images were imported from each trial into ImagelJ stack. A
scale was applied to convert pixel distances to meters. (Refer to Appendix D for more
detail.) The origin point was identified within the physical model for each trial and the
Line Tool was used to measure the distance between the origin point and the pixel that
had travelled the farthest within the arch model. The x and y coordinates were recorded
for each image, as the images are a 2-dimensional representation and did not have a z
coordinate. The absolute coordinates were calculated by subtracting the pixel coordinates
from the origin coordinates to determine the distance between the two coordinates. From
the absolute coordinates, the change of position of the dye front was calculated by
comparing the absolute distance traveled between consecutive frames; the absolute
distance of the preceding point was subtracted from the absolute distance of the point of
interest. The change in position was used to calculate the velocity by dividing the change
in position by the amount of seconds equivalent to ten frames (approximately 0.03
seconds). The outcome of this sequence were values of x and y for the experimental
model in terms of absolute coordinates and velocity.

The angle of rotation of the experimental model was measured in ImageJ for each
trial. The angle of rotation was defined as the shift in the physical model in relation to the

frame of the image. The physical model was compared to the frame of the image to check
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whether it was parallel. If the model was not parallel to the image frame, the Angle Tool
was used to measure the degree of rotation of the physical model in relation to the image
frame. The value was converted to radians and used to relate the experimental model to
the COMSOL MultiPhysics® model.

The pixel coordinates were transformed to COMSOL MultiPhysics® coordinates
using the coordinate transformation equations, Equations 6 and 7, adapted from studies

by Greinke and Willis, as shown below:

Equation 6: x,.o; = [((x — Cy) * cosf) — ((y - Cy) * sine)] + C,

Equation 7: ¥,.o; = [((x — C;) * sind) + ((y - Cy) * cos@)] +C,

Where x,,; and y,,, represent the coordinates in the COMSOL MultiPhysics® model, x and
y represent the coordinates of a point of interest in the image (after conversion to meters
and calculations), Cand C, represent the COMSOL MultiPhysics® origin coordinates,
and 0 represents the angle of rotation measured from the experimental model. The origin
point made it possible to relate the two coordinate systems, as COMSOL MultiPhysics®
does not have a clear method of establishing a customized coordinate system.

The output from the overall sequence were x and y coordinates within COMSOL
MultiPhysics® that represented the farthest moving pixel within the model as well as the
associated velocities. These coordinates were input into the COMSOL MultiPhysics®

model to compare velocity measurements.

3.4 COMSOL MultiPhysics® Model Validation Methods
The computer model was created using a student license of COMSOL

MultiPhysics® 4.4, which is a finite element analysis (FEA) multiphysics software suite
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that can simulate fluid flow, particle tracking, and mechanical stresses. The geometry was
simplified in MeshMixer and opened in SolidWorks 2011 as a solid part. Prior to being
imported to COMSOL MultiPhysics®, SolidWorks was used to create inlet and outlet

planes on the arch using the “Cut with Surface” function within Solidworks (Figure 38).
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Figure 39. SolidWorks was used to create flat, planar inlets and outlets of the arch.

The plane slice created single surfaces at each of the inlets and outlets of the arch, as
opposed to multiple faces. The sliced arch was saved as an IGES and imported into
COMSOL MultiPhysics® as the model geometry. The imported geometry was scaled (as
dimensions were lost in the resaving of the file) and moved to have positively scaled axis.
Within the imported geometry, the coordinates of the empirical model were
plotted as point geometries in the COMSOL MultiPhysics® model; for every physical
model coordinate, a point geometry was inserted into the model. Due to the planar cutting

in SolidWorks, some points were beyond the inlets and outlets of the COMSOL
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MultiPhysics® model and were omitted in the study. As the coordinates from the
physical model were 2-dimensional, having been acquired from still images, an array was
created for each point in the z-direction. Using x and y coordinates from the physical
model, the array spanned the width of the vessel in the z-direction with a point every 1

mm. An example of three point arrays can be seen in Figure 39.

Figure 40. An example of a point array in the COMSOL MultiPhysics® model.

The point arrays were used to acquire point evaluations of the velocity within the arch.
The data was exported to Microsoft Excel and the average velocity was determined
across the array, based on the assumption that the velocity from the physical model also
describes the average velocity across a path length. This allowed for a direct comparison
of a single value of the velocity within the COMSOL MultiPhysics® model and the
velocity in the physical model.

As this study is validating the physical model, fluid properties of water were used
within COMSOL MultiPhysics® with a Newtonian viscosity of 0.89 cP and a density of

1000 kg/m’. The model assumes a solid conduit with a no-slip condition at the conduit
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surface as well as a shear rate of zero at the centerline, where the fluid is at maximum
velocity. Laminar flow was selected for the study based on a Reynold’s number of 3647,
as calculated with Equation 1 and indicated by Table 2. The equation of laminar flow is

as seen in Equation 4, accounting for both inertial and viscous forces in the model.

. Inertial Forces vD
Equationl: Re = —— = pvD

Viscous Forces u

Equation4:p(g+17- W) =V-T+pg

Table 2. Flow Regime According to Reynold's Number

Re <<1 Re <2100 Re > 4000

Stoke’s Flow [N] Laminar Flow [N] Turbulent Flow [N]

The inlet was identified as the area shown in Figure 40 and the outlets were
identified as the three branching vessels and the section of the arch leading towards the

thoracic aorta.
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Figure 41. The arch inlet in COMSOL MultiPhysics®, as seen in the purple selection.

The initial conditions matched that of the physical model with an inlet velocity of 0.1436
m/s, as was measured during the empirical trials, and a viscosity of 0.89 cP (u). The
pressure change within the model was calculated using the Hagen-Poiseuille equation
(Equation 5) to be approximately 1.388 Pascal.

TR*(Pi—Po)
8uL

Equation 5: Q =
The calculated pressure change assumed gauge pressure, in which the outlet equivalent to
0 Pascal to account for atmospheric pressure within the pressure change. Additionally,
the inlet (R) is assumed to be 1 inch in diameter and the arch length (L) is assumed to be
in center of the arch at approximately 8.62 inches.
A “Fine Mesh” was used in the model, as it was the highest number of elements

that could be used without crashing COMSOL MultiPhysics®. The mesh statistics are

seen in Figure 41.
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Minimum element quality: 1.465E-7

Average element quality: ~ 0.6195

Element volume ratio: 1.541E-9
Mesh volume: 1.236E4 m®
Maximum growth rate: 153.5
Average growth rate: 1.968

Figure 42. COMSOL MultiPhysics® mesh statistics.

The study was run using a Stationary Study to output velocity and shear stress values as

well as qualitative graphs to describe the fluid properties.
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CHAPTER 4: DATA COLLECTION AND RESULTS

4.1 Flow Visualization Results

The physical model yielded both qualitative and quantitative results.
Qualitatively, the model was successful as an anatomically accurate cavity was created
within the model and there was no lateral leakage of fluid within the model. Additionally,
the model was transparent and allowed for quantitative analysis.

Five trials dye trials were conducted, three of which were analyzed in this study.
Two trials were not analyzed; Trial 4 had poor lighting (which did not allow for
thresholding of the image) and Trial 5 had a very large bubble and the frame was shifted
as the dye ran through the vessel. From those trials, 24 coordinates were determined and

21 path-length velocities were calculated.

4.2 COMSOL MultiPhysics® Data Collection

The COMSOL MultiPhysics® model used 15 of the coordinates calculated from
the physical model. Due to the planar slicing of the model needed to create inlets and
outlets, 9 of the coordinates were outside of the geometry of the COMSOL
MultiPhysics® model. (In future models choosing a different location to initialize and
end the dye front can mitigate this discrepancy. As consistent initial locations were used
between the trials, a few points were unusable from every trial.) As previously
mentioned, an array was created in COMSOL MultiPhysics® and used to find the

average velocity at the coordinate points.
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A qualitative velocity graph of the arch cross-section, as seen in Figure 42, shows
a streamline within the center of the arch of the maximum velocity. The color gradient

depicts the velocities within the arch.

Figure 43. Cross-sectional plot of the arch velocity.

The interior of the arch has the highest velocity with lower velocities towards the walls
and the thoracic aorta outlet of the arch. Another qualitative result is seen in Figure 43,

showing an arrow plot of the velocities within the arch.
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Figure 44. Arrow plot depicting velocities within the arch.

The arrow plot depicts the direction and magnitude of the fluid within the arch and notes
the maximum and minimum velocities within the arch. As expected, the maximum

velocity is at the centerline of the vessel and the minimum velocity is at the vessel wall.

4.3 Comparative Results

The following graphs show the three experimental trials plotted in comparison to
the equivalent COMSOL MultiPhysics® coordinates. As previously mentioned, the
experimental velocities were calculated by measuring the distance between the furthest
downstream point of dye in one frame to the furthest downstream point of dye in the

preceding frame. The distance was divided by the time between frames and represents the
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average velocity at the furthest point. The velocities from the COMSOL MultiPhysics®
model were calculated using the average velocity from an array of point evaluations at
the same coordinates as the dye point in the physical model. The point positions used in
the graphs were assigned as an integer based on the sequence of occurrence within the
trial.

As seen in Figure 44, Trial 1 differed the most in velocity at the first point

position with a higher experimental velocity, but was otherwise consistent.
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Figure 45. Scatter plot of Trial 1 comparing the COMSOL MultiPhysics® and experimental velocities.

As seen in Figure 45, Trial 2 differed at the first coordinate point with a higher
experimental velocity. Otherwise, the experimental velocities were less than the

COMSOL MultiPhysics® velocities.
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Figure 46. Scatter plot of Trial 2 comparing the COMSOL MultiPhysics® and experimental velocities.
As seen in Figure 46, in Trial 3 the first dye point was very similar. As the dye

front moved through the vessel, the experimental velocities were less than the COMSOL

MultiPhysics® velocities.
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Figure 47. Scatter plot of Trial 3 comparing the COMSOL MultiPhysics® and experimental velocities.
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4.4 Statistical Comparison

The statistical analysis comparing the physical model results and the COMSOL
MultiPhysics® results was calculated using a Paired 2-Sample T-Test in JMP. For this
study, alpha was set to 0.05, the confidence interval was set to 95%, and the alternative
hypothesis denotes a significant difference in the samples. The output, as seen in Figure
47, has a p-value of 0.1058 which is greater than 0.05; therefore, we fail to reject the null
hypothesis as there is not significant statistical evidence to conclude a difference between

the physical model velocities and the COMSOL MultiPhysics® model velocities.
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Figure 48. The JMP statistical analysis showing no significant difference between the experimental and
COMSOL MultiPhysics® values.
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CHAPTER 5: DISCUSSION

5.1 Interpretation of the Experimental Model

One aspect of this study was to create a three-dimensional, physiologically
accurate construct of the aortic arch using additive manufacturing techniques for the
purpose of clinical testing. The methods developed in this study used to create a physical
model were effective and met the purpose of the study. The construction of the model
utilized widely available 3D printing to maintain a physiologically accurate
representation of a patient anatomy. All support material was removed in the process and
the cavity within the model was an accurate representation of the intended STL file. The
selected material for the model was transparent and did not become damaged during
experimentation.

This model could be used in a clinical setting or in a research and development
setting. One application would be to use CT scans from difficult patient anatomy to
create new models; the subsequent model could be used as a training tool for surgeons to
practice the use and deployment of medical devices within the aortic arch. The purpose
would be to reduce surgical error and improve the adoption of new medical devices.
Another application would be to use the model to test a medical device while in the
development or validation stage. The model can be used to help visualize the sequence of
use of the device and be incorporated into quantitative evaluation, as will be further

elaborated on in Section 5.2.
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5.2 Interpretation of the COMSOL MultiPhysics® Model and Comparison Study

The COMSOL MultiPhysics® model had two purposes: to iterate on the work by
Andrew Janicki and to serve as a comparator to the physical model. The primary
improvements on Janicki’s model were the increased STL file mesh size and the accuracy
of flow conditions within the arch. The studies by David Baik and Brandon Cohen, as
undergraduates contributing to this study, utilized MeshMixer and SolidWorks to
increase the number of faces on the model. Additionally, in COMSOL MultiPhysics®
studies, a significant difference was shown between Janicki’s model and Baik’s model
when using laminar flow. The findings from these studies were incorporated into the
comparator study that was used to validate the experimental model. (Refer to external
reports for more detail on Baik and Cohen’s studies.)

The qualitative COMSOL MultiPhysics® outputs, specifically the velocity and
arrow plots, showed higher velocity towards the center of the vessel and lower velocities
towards the edges of the vessel. This result is accurate in accordance with the Hagen-
Pouiselle equation and is as expected to have a maximum velocity in the center
streamline of the vessel [N]. The qualitative graphs also demonstrated a lower velocity in
the fluid after the outlets of the three branching vessels. This is likely due to the loss of
fluid from those outlets, resulting in lower fluid flow in the remainder of the vessel and
therefore a lower flow rate and velocity.

The scatter plot graphs depicting the experimental velocities in comparison to the
COMSOL MultiPhysics® velocities had a few qualitative inconsistencies. At the first
data point for all three trials, the experimental value was equivalent or lower to the

COMSOL MultiPhysics® value. This discrepancy could be due to the lack of uniform
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flow at the entrance of the vessel. While the diameter of the tubing from the pump
matched the diameter of the inlet, uniform flow and velocity within the arch could not be
guaranteed at the inlet. The fluid flow may have been faster in certain aspects of the inlet
of the model, causing the higher velocity in the experimental model. The remainder of the
data points, across all three trials, had lower experimental velocities than the COMSOL
MultiPhysics® velocities. This could be due to a discrepancy of the inlet velocity
location; while the measured velocity was equivalent to the initial COMSOL
MultiPhysics® condition, the planar slicing in SolidWorks removed a portion of the
bottom of the arch in the COMSOL MultiPhysics® model and moved the fluid inlet
further up the arch. While not much of the arch was removed, the change could have
increased the velocity throughout the COMSOL MultiPhysics® simulation.

While the results differed slightly, the statistical analysis of the COMSOL
MultiPhysics® simulation velocities in comparison to the physical model velocities
confirmed the accuracy of the in silico study. As there was no statistically significant
difference between the empirical and in silico models, the study showed that the
conditions created within a physical, anatomically accurate model can be emulated using
a computer model. While a physical model is useful for various reasons, a computer
model uses fewer resources to create, reduces computational steps, and can output more
values from a single study. For instance, the COMSOL MultiPhysics® model could also
be used to visualize the magnitude and direction of the velocity, as seen in the arrow plot,
or output the shear stress in an area of the vessel.

This validation of the accuracy of the COMSOL MultiPhysics® model makes it

applicable to medical device testing. The Food and Drug Administration (FDA) is the
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regulatory body within the United States responsible for the approval and clearance of
medical devices and procedures [43]. The FDA recognizes computational models, such
as finite element analysis, as a tool to evaluate the safety and effectiveness of medical
devices. An FDA guidance document is publicly available for the submission of
“Computational Fluid Dynamics and Mass Transport”, outlining the requirements for the
submission of a computational model. Those requirements include and are not limited to
descriptions of the system geometry, governing equations, system properties, boundary
and initial conditions, and validation [45], aspects that were all met within this study.
There are a variety of methods available to validate computational models, with no
specific protocol yet defined within the medical community. Within computer modeling,
validation is the “substantiation that a computerized model within its domain of
applicability possesses a satisfactory range of accuracy consistent with the intended
application of the model.” (Schlesinger et al. 1979) [47]. The validation method within
this study used a real world system to statistically validate a finite element analysis model
and could hypothetically meet FDA requirements for submission.

An example of the value of FEA analysis is with a device for intervertebral body-
fusion devices (IBFDs). The FDA required the company to test all of the products for
different areas of the spine, despite having very similar designs and variations to match
patient anatomy. The physical testing would have cost the company $1.2 million, making
the project uneconomical. The company was able to show that the weakest IBFD, in
terms of FDA testing criteria, could still pass FDA standards using FEA modeling. With

computer modeling, the company was able to reduce the time, cost, and risk associated
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with full-scale testing of the product and bring the product to market within the United
States [46].

In the example of Claret’s Sentinel CPS, the use of FEA and the validation of the
computer model could be applicable in using COMSOL MultiPhysics® for particle
tracking. As the company is developing the device and submitting for FDA approval,
there is a need for quantitative evidence that the device removes particles from the
vessels branching to the cerebral system. As shown in Janicki’s study, COMSOL
MultiPhysics® has the functionality to track particles within geometries. By combining
the validation of this study and the improved parameters of Janicki’s study, particle
tracking could be performed in COMSOL MultiPhysics® to show the effectiveness of the

device while reducing the cost and time associated with physical models.
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CHAPTER 6: SUMMARY & CONCLUSIONS

6.1 Contributions to Biomedical Engineering

The results of this study contributed to the field of biomedical engineering by
creating a method of application for CT scans, further establishing a novel technique of
flow visualization, and successfully performing in silico validation. The creation of a full
vessel model is useful for both engineers and clinicians. While there are vendors that
make vessel models, this technique was done with limited equipment and a budget of
approximately $350. It could very easily be applied to different geometries and be used
as an in house method of creating new models, for reasons previously mentioned. This
study also utilized a method of flow visualization recently developed in two previous
studies; by further developing the method, two of the three studies have now successfully
used this method of flow visualization to validate a computational model. Finally, the
validation of the in silico model contributed to the field of biomedical engineering by

establishing a protocol and potentially contributing to the test methods of Claret Medical.

6.2 Study Limitations

While the study was successful, there were limitations associated with the
physical model and computer model. Limitations of the physical model include the seam
between the two halves and the step sizes from 3D printing. While efforts were taken to
mitigate this issues, including using a resin to fill in the step-sizes and bonding with the
optimal technique, ridges were still present in the model that were not present in the
COMSOL MultiPhysics® model and may have altered the fluid flow within the arch.

During experimentation the model was interchanged with multiple inlet and outlet press-
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fit tubes, which caused a slight separation of the two halves. Further damage was stopped
by using a C-clamp to hold the halves together. In the future, this can be mitigated by
measuring the inlet and outlets of the model to not exceed the size while press-fitting
attachments. For the experimental set-up, additional lighting should be used to better
visualize the arch. A significant limitation was that a uniform velocity could not be
achieved at the inlet and the presence of bubbles in the model. While efforts were taken
to limit these factors, further methods should be developed to improve the uniformity of
inlet velocity and decrease frequency of bubbles.

Within the COMSOL MultiPhysics® model, as with all finite element
simulations, there were limitations of the accuracy of the simulation. The program
required a simplification of the original geometry to be able to process the file size. The
mesh size that was used had the highest number of elements possible with the file size, as
finer mesh sizes caused the program and simulation to crash. Another limitation was that
the version of COMSOL MultiPhysics® used, COMSOL MultiPhysics® 4.4, lacked the
ability to define distinct coordinates. The coordinates of the origin point were obtained
through a study run with the same geometry and parameters. The study was equivalent,
but had to be run prior to the comparison study, as the program version did not have the
capability of displaying coordinates. Finally, the discrepancy of the COMSOL
MultiPhysics® inlet location in comparison to the physical model inlet location may have
caused a change in velocity throughout the model. In future studies, the planar cuts
should be included in both models to eliminate the change of inlet position.

For the overall study, the significant limitations were associated with simulating

in vivo conditions. The pressure was not controlled at the inlet and outlet and was
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atmospheric in this study; this would not be the case in vivo as there are different
pressures within the body. A second aspect is that pulsatile flow would better mimic
blood flow within the body, but was outside the scope of this study. Similarly, water was
used to simulate fluid in this model for budget and scope reasons. Blood, or a fluid with
similar properties, would better emulate physiologic conditions for testing. Finally, the
geometry used in this study was a simplified model of real patient anatomy. An
assumption of this study is that the simplification of the model maintained the significant

characteristics of the anatomical features.

6.3 Future Work and Conclusions

Transcatheter aortic valve replacement is a developing minimally invasive
procedure and is very relevant in the medical field. As TAVR and similar procedures
continue to develop, the need for experimental evaluation and visualization of devices
will continue to grow, making this project relevant to many companies in the medical
device industry. In future iterations of this study, fluid with physiologically accurate
properties should be incorporated. Blood is a non-Newtonian fluid, which could change
the results of the model. Incorporating a fluid similar to blood would better mimic
conditions in the body for device testing. Additionally, different patient scans could be
used to emulate difficult anatomies. Within the computer model, different anatomies
could be compared to determine if fluid flow differs and in what way. Within the physical
model, the model could be extended to include inlets for medical devices and the model
could be used as a training device for physicians in difficult anatomies. Finally, all the

studies of Janicki should be repeated with the improvements indicated in this study and in
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the reports of Baik and Cohen. Additionally, the limitations of this study should be taken
into consideration and mitigated.

In conclusion, this study used CT scans from Claret Medical to create an
anatomically accurate physical model and improve an existing computational model. The
computational model was successfully validated using a novel technique of flow
visualization. The validation of the computational model is applicable to TAVR
procedures and the method could be applicable for different anatomies and other

procedures within the aortic arch.
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APPENDICES

Appendix A: MeshMixer Processing of the STL File

Written by Brandon Cohen

This is a protocol on how to transform a CT scanned part into a part that can be
opened and manipulated in SolidWorks. This is important when 3D printing of the part is
necessary, for if the part is too large of a mesh, it can not be opened in SolidWorks and
many other 3D programs. This protocol uses Autodesk MeshMixer, SourceForge
Meshlab, and Netfabb Basic to accurately cleanup the part, minimize the mesh size, and
prepare it for exporting into SolidWorks. All three of these programs are freeware, and
download links are supplied below.

Autodesk MeshMixer
Autodesk MeshMixer is free software used for altering STL files. Download

MeshMixer at http://www.meshmixer.com/download.html.

NOTE: Since MeshMixer is a free tool, it is prone to crashing. Save early and often. Get
into the habit of saving after every change is made.
Import .STL file into Autodesk MeshMixer:
1. File > Import > Select file
a. You can also import by clicking Import in the top left panel (giant “+”)
2. Once Imported, your part will be shown like below. Notice in the bottom right
corner of MeshMixer the number of vertices and triangles of the part is
shown. This is important to keep in mind, for SolidWorks can generally

handle up to 10,000-11,500 triangles (or faces).
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@ Autodesk Meshmixer - HW_sm3x_red.stl.stl =]
File Actions

View Help Feedback MyAccount

SSSSS

““““““““

Shaders

1058AM |
2/28/2016

s D)

Smooth the Part as a Whole:
1. Choose Select (on left panel) = double-click part to select entire part (notice it
changes color, in this case orange)

2. Deform = Smooth
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@ Autodesk Meshmixer - HW_sm3x_red.stl.stl =]
File Actions View Help Feedback MyAccount

Edit 4
_
- Convert To >
Import
— Deform. 4
)
Modify. 4
Meshmix oft Transform Shift+T
Select # s
/ Brush Mode

Sphere Brush

Size

Filters

Expand Mode

Allow Back Faces

Crease Angle Thres

1059aM |
2/28/2016

S [ )
3. Keep Smooth settings as shown (notice the part is now shown as a preview of
what it will look like if these settings are accepted)

4. Accept
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@ Autodesk Meshmixer - HW_sm3x_red.stl.stl =]
File Actions View Help Feedback MyAccount

Smooth
=" ]
- Smoothing Type
Import
Shape Preserving ¥
Smoothing 1
L)
—_—
Meshmi

Smoothing Scale 4
< —
/ Constraint Rings

—

L e

1059aM |
2/28/2016

E A L D)

Reduce the Mesh Size (decrease triangle count)

1. Select = double-click part to select entire part

2. Edit > Reduce
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@ Autodesk Meshmixer - DEMO Cleanup.mix =
File Actions View Help Feedback MyAccount

Edt > Erase & Fil F
g
o Convert To. > Discard X
— Deform, >
Remesh R
X) Modify. >
Meshmix Extrude o
Select ® a Extract shiftsD
/ Brush Mode N Offset Ctri+D
Select
— Sphere Brush v Tube Handie
B 55 Bridge Ctri+B
———
. Join J
Souit Symmetry X

— Weld Boundaries
@ Filters a Separate

SSSSS

Expand Mode rgft-cickedrag Plane Cut

§ GeodesicDistance ¥
Edit
Anal;

Allow Back Faces
rease Angle Thi
Crease Angle Thres 0 Flip Normals

P
Fit Primitive P

1202oM |
2/28/2016

e

3. Select how you want to reduce the mesh size (‘Reduce Target’). This can be done
in three ways: Percentage, Triangle Budget, and Max Deviation. It is
recommended to use Percentage or Triangle Budget. Once an option is chosen,
ensure that ‘Reduce Type’ is set to ‘Shape Preserving’.

4. Use the appropriate slider (slider associated with ‘Reduce Target’ that has been
chosen) to adjust the part mesh size. Again, the part will change and show a
preview of what it will look like prior to accepting the change.

5. Recommended to use Percentage reduce target initially, and change the
Percentage slider to 70%.

6. Accept

a. Notice that the Triangle Count of the part decreases (lower right corner).
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@ Autodesk Meshmixer - DEMO Cleanup.mix =

File Actions View Help Feedback MyAccount

Reduce

Reduce Target

Percentage v

Percentage.
Triangle Budget

Iax Deviation

Percentage 0 %

———

Tri Count 1000

o

Max Deviation 056 mm
@

¥l Preserve Boundaries

Preserve Group Boundaries

1no07am |
2/28/2016

E A L D)

Cleaning up/Smoothing out Specific Sections:

1.

Select - click on area of interest (this can be done by clicking on a specific area,
or click and hold to paint a certain area). The selection brush size can be changed,
by adjusting the ‘Size’ slider under ‘Select’ tab. The area that has been selected

and will be modified is now a different color (orange).
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2. Edit 2 Erase & Fill

@ Autodesk Meshmixer - DEMO Cleanup.mix

File Actions View Help Feedback MyAccount

—

Import

Edit >
Convert To >
Deform >
Modify. >
Select L 2N
Brush Mode
Sphere Brush v
Size 12
—_—
Symmetry X
Filters a

Expand Mode
Geodesic Distance ¥

Allow Back Faces
Crease Angle Thres 0

Discard

Reduce ShiftsR
Remesh R
Extrude D
Extract Shift+D
Offset CtrisD
Tube Handle

Bridge Ctri+B
Join J

Weld Boundaries
Separate

Plane Cut

Fiip Normals

Fit Primitive

=
11:31 AM
2/28/2016

D)

3. Leave default settings. Again, a preview of the change is shown prior to accepting

the change.

Accept

5. Clear Selection to deselect the area of the part that was just altered

6. Repeat for all areas of interest that need to be smoothed out
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@ Autodesk Meshmixer - DEMO Cleanup.mix =
File Actions View Help Feedback MyAccount

Replace
- Replace/Fill Type
Import
Smooth MVC v
X% Refine 50
—_——
Meshm
Smooth 100

</ | ——

Scale 1
Select
~ ———
Buige 0
——
Sculpt
= Create New Groups

Replace a region of the mesh

=
11:32 AM
2/28/2016

D)
Removing Sections of the Part:

1. Select = select area of interest (notices it changes color)
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@ Autodesk Meshmixer - DEMO Cleanup.mix
File Actions View Help Feedback MyAccount
J

Edt > Erase & Fil
=]
-~ Convert To >
Import
Reduce ShiftsR
Deform, >
X Remesh R
Modify. >
Meshmix Extrude D
Select ® a Extract Shift=D
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2. Edit & Discard

@ Autodesk Meshmixer - DEMO Cleanup.mix
File Actions View Help Feedback MyAccount

w 11:35 AM
"
B0 e
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Removing Sections of the Part: Troubleshooting
1. If there are “floating meshes” still present after removing the section of interest,
they can be removed by performing the same steps as above (clicking on
individual triangles) or by this method (selecting by drawing around the floating
triangles).

@ Autodesk Meshmixer - DEMO Cleanup.mix
File Actions View Help Feedback MyAccount

nssam |
2/28/2016

E A L D)

2. Select = instead of clicking on individual triangles, draw a circle around the
floating triangles by clicking and holding down the mouse. You will see where
you are drawing with the red line left from your cursor. Ensure that you close up

your loop around the floating triangles. NOTE: Before moving to the next step,
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make sure you did not accidentally select any other areas of the part (zoom out

and examine the part for a change in color, indicating part selection).

@ Autodesk Meshmixer - DEMO Cleanup.mix =
File Actions View Help Feedback MyAccount

# Brush @) @ Lasso
—
"
Import Select
-~ | Brush Mode
L
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3. Edit = Discard
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@ Autodesk Meshmixer - DEMO Cleanup.mix =
File Actions View Help Feedback MyAccount

€N = K} -roe 2=

NOTE: If you have accidentally removed more than you wanted, you can undo the last

action by going to Action - Undo|Back (or Ctrl+z).

Filling a Hole using MeshMixer:

1. Select > Select area around the hole you desire to fill

2. Edit 2 Erase & Fill
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Select # a Extract
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3. Check the preview of how MeshMixer will fix the section. If you like the

preview, click Accept
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@ Autodesk jxer - DEMO Cleanup.mix

File Actions View Help Feedback MyAccount

Replace

Replace!Fil Type

Smooth MVC

v
@ Refine 50
o

m
3

@ Qi

(9]

Shaders

cW o IAEY e

NOTE: It can be challenging to fill holes exactly how you would like them to be filled in

MeshMixer. Later on in the process, NetFab Basic is used to again check for holes, and
will repair the part (fill all holes). However, NetFab Basic does not allow for any control
on how the holes are filled, so it is recommended to attempt to fill holes using

MeshMixer for it allows more control on the shape the part will take.

Separating Sections in MeshMixer:

1. To separate sections in MeshMixer, Select—> highlight section you wish to

cmove
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File Actions View Help Feedback MyAccount

]
o

Import

Edit > ; Erase & Fil

Discard

Convert To. >
Deform >
Modify. >
Select & a
Brush Mode g

Sphere Brush

Size 16
———
Symmetry X
Filters a
Expand Mode eptcickty

Geodesic Distance ¥

Allow Back Faces
Crease Angle Thres 0
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Edit > Separate.

Reduce
Remesh

Extrude

Extract

Offset

Tube Handle
Bridge

Join

Weld Boundaries
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Plane Cut
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Fit Primitive

HW_sm3x_red.stl.stl & ©

_urﬁx red.stl.stl (solid)

-
229PM
2/15/2016

E A L D)

NOTE: Once you click Separate, the highlighted region will become its own

section (own piece in the object browser window). There is no preview or accept

button associated with Separate, so if you made an error in the section you wanted

to separate, use Action > Undo|Back (or Ctrl+z) to remove the change.
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Autodesk Meshmixer - Arch Cleai
File Actions View Help Feedback MyAccount

L Edit > Erase &Fill F
ﬁJ-J
Convert To. > Decard X
Import
Reduce shift-R
Deform >
Remesh R
b Wodify >
Do Extrude [}
Select # s Extract Shift=D
/ Brush Mode qff Offset Ly
Select
- Sphere Brush v Tube Handle
P
[ Size) 16 Bridge Ctri+8
——
Join J
Sculpt Symmetry X
- Weld Boundaries
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e Expand Mode cgesckas ] Plane Cut
( Geodesic Distance ¥
®
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Clear Selection

.
€ B = ki T

3. The section is now its own object in the object browser. To delete this section,

ensure that you have just this section selected (rest of the part is dimmed when
only one object is selected), and click the trash can ‘Delete’ button in the bottom

right of the Object Browser.
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@ Autodesk Meshmixer - Arch Cleanup Lmix
File Actions Feedback

View Help My Account

Object Browser
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Print
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Autodesk Meshmixer
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Final Triangle Size Check:

l.

Prior to exporting the part, double check the number of triangles in the mesh
(bottom right corner of MeshMixer window). SolidWorks can generally handle
10,000-11,500 triangles. If you are not in this range, you can reduce the mesh size
by using a ‘Triangle Budget’ reduction. This is better to do once your part is near
the range required (10,000-11,500), for it will not drastically alter the shape and
“cleanliness” of the part.

To reduce the mesh size further, Select = select entire part (double click part)
Edit > Reduce

Change “Reduce Target” to “Triangle Budget”. The “Tri Count” slider is now
able to be changed.

Side to desired mesh triangle count. A preview of the part is shown. Click Accept

if the changes are desired.
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@ Autodesk Meshmixer - DEMO Cleanup.mix =
File Actions View Help Feedback MyAccount

Reduce
=" ]
Reduce Target
Import
Triangle Budget v
X) Reduce Type
Shape Preserving ¥
Meshmi
Percentage 50 %
/ e
Select Tri Count 10211
—
Max Deviation ~ 0.73 mm
Saulpt @
¥l Preserve Boundaries
Preserve Group Boundaries

nasam |
2/28/2016

E A L D)

Exporting Part for Mesh Count Check:
1. File > Export
2. Saveitasa “.PLY” file type. Save it in the location of your choice. Remember

where the file is saved for ease of locating it for further use.
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@ Autodesk Meshmixer - cleaned up shortened, 10000faces (repaired).stl - X
FileN Actions View Help Feedback MyAccount
Open Ctrl+0

Save Ctrl+S
Save As Ctrl+Shift+S
Import 123D

Save To 123D
Save as a copy to 123D

Import

Import Bunny
Import Sphere
Import Plane

Import Parts Folder

Import Reference

Export Ctr+E
Export SVG

Send to 123D Design

Preferences Ctrl+Enter

Start Screencast

SourceForge Meshlab
Meshlab is another free software that can be used to manipulate parts for 3D

printing. Download Meshlab at http://meshlab.sourceforge.net/

Exact Mesh Count in Meshlab:

1. File = Import Mesh
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© MeshLab_64bit v1.3.3 - [Project_1] - X
& File Edit Filters Render View Windows Tools Help & x

R @D | EF [ | QPN cOH® & /WS ThIEED X X

&  Open project... Ctrl+0

Append project to current...
Save Project Ctri+S
Close Project

o Import Mesh... Ctrl+|
Export Mesh... Ctrl+E
Export Mesh As..

> Reload Alt+R
Reload All Ctrl+Shift+R

J Import Raster...

Save snapshot

Recent Projects

Recent Files

Exit Ctrl+Q

2. Locate and select the part file of interest.

3. Filters - Remeshing, Simplification, and Reconstruction - Quadratic Edge

Collapse Decimation
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& Meshlab_64bit v1.33 - [Project 1] Alpha Complex/Shape Zippering

& File Edit Render View Windows Tools Help CSG Operation
Apply filter Ctrl+P Close Holes
Show current filter script Clustering decimation
Selection N Convex Hull
e R N Crease Marking with NonFaux Edges.
Create New Mesh Layer N Curvature flipping optimization
e R Cut mesh along crease edges
R Delaunay Triangulation

Polygonal and Quad Mesh
Iso Parametrization

Color Creation and Processing »
Sarten T e i N Iso Parametrization Build Atlased Mesh
O e e Gopetiatons R Iso Parametrization Load Abstract Domain
Normals, Curvatures and Orientation » Iso Parametrization Remeshing

Meshayer N Iso Parametrization Save Abstract Domain
Raster Layer 5 Iso Parametrization transfer between meshes
Range Map R Marching Cubes (APSS)

Point Set R Marching Cubes (RIMLS)

Sampling R Mesh aging and chipping simulation
Textine N Planar flipping optimization

Points Cloud Movement

Camera

Quadric Edge Collapse Decimation

Quadric Edge Collapse Decimation (with textu Simplify 2 mesh using 2 Quadric

Refine User-Defined based Edge Collapse Strategy; better
than clustering but slower

Simplfication: MC Edge Collapse
Subdivision Surfaces: Butterfly Subdivisi (filter_meshing.dll)
Subdivision Surfaces: Catmull-Clark

Subdivision Surfaces: LS3 Loop
Subdivision Surfaces: Loop
Subdivision Surfaces: Midpoint
Surface Reconstruction: Ball Pivoting
Surface Reconstruction: Poisson
Surface Reconstruction: VCG

Tri to Quad by 4-8 Subdivision

Tri to Quad by smart triangle pairing
Turn into Quad-Dominant mesh
Tum into a Pure-Triangular mesh
Uniform Mesh Resampling

Vertex Attribute Seam

Voronoi Filtering

Voronoi Vertex Clustering - 11:53AM |
pall
2/28/2016

4. Enter your Target Number of Faces (10,000 in this example). Keep the other
number options as the defaults (shown in following image). Check the following
boxes: Preserve Normal, Preserve Topology, Optimal position of simplified

vertices, and Post-simplification cleaning.
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& MeshLab_64bit v1.3.3 - [Project_1]

=@ X

Fyr——
NFCY®

Simplfy & mesh using & Quadic based Edge Colapse
Strategy; better than clustering but slower

Target number of faces 10000
Percentage reduction (0..1) 0
Quality threshold 0.3
[7] Preserve Boundary of the mesh
Boundary Preserving Weight 1
Preserve Normal

[] preserve Topology

Optimal position of simplified vertices
[”] Planar Simplification

[7] weighted Simplification
Post-simplfication deaning

[C] simpify only selected faces

TrBaEo iR cOl® -6 /B ETREIEED X XX

( Default ] [

( Cose ]

=& x

5. Apply. Notice that in the bottom purple bar, the number of faces now reflects the

target number you entered previously.

6. File > Export Mesh As... export the mesh as a “.PLY” in order to be imported

into Netfabb Basic for repair/hole checking. Be sure to remember where you

saved the exported file.
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& MeshLab_64bit v1.3.3 - [C:/L ktop/Allie thesis cleanup.mlp]

O(File] Edit Filtrs Render View Windows Tools Help
" New Empty Project... CtleN M ﬂz[j] 1
& Open project... Ctrl+0 —

Append project to current..

Save Project Ctrl+S
Close Project

5 Import Mesh... Ctrl+I
Export Mesh... Ctrl+E
Export Mesh As...
Reload Alt+R
Reload All Ctrl+Shift+R

5 Import Raster...
% Savesnapshot

Recent Projects

Recent Files

Bt Ctrl+Q

16 pu

COR® -4 /BTR

Netfabb Basic

Netfabb Basic is free software used for cleanup of STL files. Download at

http://www.netfabb.com/downloadcenter.php?basic=1

Repairing the Part:
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1. Open Netfabb Basic. This registration popup screen will appear. Select “I accept

the terms of usage” and click Later.

@ MeshLab_64bit v1.3.3 - [C:/Users/brcohen/Desk llie thesis cl p.mip] = x

Y

NFwceomses D800 QPN cOH® ¢ /BT E

- &) x

You can also register directly on our Website:
http://www.netfabb.com/register

Terms of use for netfabb® Basic:

IThis "netfabb®" is a full-featured freeware edition. You are allowed to
use and redistribute this software for free without registration, but it is
prohibited to sell the software or to sell any copies of the software.
Furthermore, any form of decompilation, disassembly or reverse
engineering of the software is not allowed

By infringement of these terms of use it expires immediately and all
rammerrial nrofits ait of the nse of the saftwars - direct or indirect -

[¥]1 accept the terms of usage

GetKey ] [

2. Project > Add Part. Locate and select your part.
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netfabb Basic 7.3

Part Extras View Settings Help Upgrade now!

Project = Edit

[

Parts

Slices

’J

Context Area

Rtfa vpb@® +@ =v

D006

10080

Ctrl+N
Ctrl+0

¥ Open
.\ AddPart

Cuts.

<cutting disabled>

0.00 [cm®

Reset

0.00 [cm®

Volume:

mm

0.00

Area:
Trianges:

mm
00f 0 parts are selected

Upgrade now!

0.00 | mm

0.00

Information
Length

Width:
Height:

e

ARAEIH

XX

HAX I KR AN KX

AARBRALGRRAXR,
SRR,

RO
AURRRCRE AL,
OB

R RAARIARRGERAA

LR

XAS

I

(AR

AR
LA

AN IO

AR

SO

BB

OO

KOBSAONAOOAN

SOOOBOOB

OO

OO

OGO

R OOEOAOBORAN

ORAANAN

nced display functions

%
XA
(XAAXX

KXXAXKHIODONXX XX
N
AR 0000000‘00090000

AR
KA K NAXRIK
ORIBAEK e
OO0

o

e

XXX
R
AR

RN
iy K

K NRAAA N KNHA

OO X OO 7
e
AN

KRS

WA

R0
AR

LR

¥
QARG

LAHAIRAY

R

File Preview Browser

Ctrl+S

H s

K soees

& spiitlarge STLfile...(Pro)

Q Autodesk Spark [Beta]

Print Screenshot

&

kL) Configure Printer..

® it

Move and rotate the selected parts by the mouse and the cursor keys

Rotate/Move

©
]
g
g

t checks it for any holes in the part.

ic, 1

3. When your part is loaded into Netfabb Bas

If there are holes present, there will be a warning triangle in the lower right corner

of the window. Additionally, the holes will be shown in red on the part. NOTE

ing in

it and no warn

101nS on 1

Even if you load your part, and there are no red locat

1s repair step to

11 follow the rest of th

i

ht corner, you should st

18

the bottom r

ensure your part loads properly in SolidWorks.

101



==X netfabb Basic 6.1 - DEMO Cl

B W VS W

Project Edit Part Bdras View Settings Help

PaAB BHO000080 S9OBQ ML) 9L R- +@ - =v

102

2 |®  Parts =4
; = Slices &
i
cuts
x D <& » 000 mm
v <& » 000 mm
z[) « [J» 000 mm
(g 3
[ Executect | Reset )
Information
Length: 21800 mm Voume:  — om
Width: 11863 mm  Area: - e1246 o
Height  190.37 mm Triangles: 10000

10f1 partis selected.

Upgrade now!




==2 netfabb Basic 6.1 - DEMO Cleanup.fabbproject

Project Edit Part Bdras View Settings Help Upgrade now!

AR 000080 SDOG Q)

2 |® D Parts "3
2| = slices -
-3
o
3
8
Cuts
x [ <& » 000 mm
v. O <& » 000 mm
z[J « [Jr 000 mm
[<c|mmg disabled> vl
Information
Length: 21800 mm  Volume: — om
Width: 11863 mm Area: 41246 cm?
Height: 19037 mm  Triangles: 10000
10f1 partis selected.
Upgrade now!

 and rotate the selected parts by the mouse and the cursor keys

4. Click on the Red Cross in the top toolbar (Repair button).

Z-2 netfabb Basic 6.1 - DEMO Cl i oo D e

Project Edit Part Bdras View Settings Help Upgrade now!

*AR 000000 SVOBC VL2 vy R $a - =v

- o & ) Parts >
S = sli
2| = slices -
-3
o
3
8
Cuts
x [ <& » 000 mm
v. O <& » 000 mm
z[J « [Jr 000 mm
[<c|mmg disabled> vl
Information
Length: 21800 mm  Volume: — om
Width: 11863 mm Area: 41246 cm?
Height: 19037 mm  Triangles: 10000
10f1 partis selected.
Upgrade now!

rotate/move move and rotate the selected parts by the mouse and the cursor keys

<t
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5. The part now changes color, and shows all of the individual triangles. On the right
toolbar, leave all of the repair settings at the defaults. Click Automatic Repair in

the bottom of the right toolbar.

%

3 Basic 6.1 - DEMO Cl i i Y — e s A %

Project Edit Repair Meshedit View Settings Help

AR 000000 040[den|4d40844444 +a =v

= ) Parts
@ © DEMO Cleanup (100%)

Part Repair

4
13 [E1]

1]

eale powon

Slices

Status | Actions | Repair scripts | View

Statistics
Edges: 15004  Borderedges: 8
Triangles: 10000 invalid orientation 0

Shels: 10 Holes: 2

@] avto-pdate
Visualization

Highlight holes. (] Triangle mesh
Showedgesfrom [ (J 45

[V] Show degenerated faces

Surface selection

Selection tolerance 90°

msoriermar | [ somene |

Press Shift to add / remove triangles to /from the current selection

3 € = P el

6. Select Default Repair in the popup window. Click Execute. Then click Apply

Repair on the right toolbar.
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Basic 6.1 - DEMO Cle

lol@| = |

Project Edit Repair Meshedit View Settings Help

PAR 009080 Q40/[don(4d40d4d444 +a=v

eaue papod

Default repair

Simple repair

= ®) Parts -
= @ @ DEMO Cleanup (100%) ®
o Part Repair L 4]
= Slices -
Status | Actions | Repair scripts | View
Statistics.
Edges: 15004  Borderedges: &
Triangles: 10000 invaiid orientation 0
Shels: 10 Holes: 2
@ auto-update
Visualization
[¥] Highlight holes (] Triangle mesh
Show edges from 45
[V] Show degenerated faces
Surface selection
Selection tolerance £

Press Shift to add / remove triangles to /from the current selection

22 netfabb Basic 6.1 - DEMO Cl . X i

T ———y = X~
Project Edit Repair Meshedit View Settings Help

PAR 000000 040[don|4d0ddd4€d +a =V

eaue papod

= ®) Parts
= @ @ DEMO Cleanup (100%)
Part Repair
Slices

ellos

Status | Actions | Repair scripts | View

Statistics.
Edges: 15004  Borderedges: ©
Triangles: | 10000 invalid orientation 0

Shels: 10 Holes: 2

@] avto-pdate
Visualization
[] Highiight holes.
Show edges from

(] Triangle mesh

[V] Show degenerated faces

Surface selection

Selection tolerance 90°

Ifrom the current selection
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7. Click Remove Old Part in the next popup window. The part is now shown green
again, and there is no warning triangle in the bottom right of the window. Your

part is now ready for exporting.

Basic 6.1 - DEMO Cl je =@ = |
Project Edit Repair Meshedit View Settings Help

PaB 80969689 04C/don4d40844d44d +a=v
2| = & Parts =3
2 = @ @ DEMO Cleanup (100%) ®
5 o Part Repair L4C)
8| = Slices 7
Status | Actions | Repair scripts | View
Statistics
Edges: 14961 Border edges:: 0
Triangles: 9974 invalid orientation 0
Shels: 1 Holes: [)
_m- (V] auto-update
Visualization
[¥] Highlight holes (] Triangle mesh
Showedgesfrom [ (J 45
[V] Show degenerated faces
Surface selection
Selectontolerance | () 90°

106



22 netfabb Basic 6.1 - DEMO Cl je ———— % L% [E=RTa ™™

PaB 000000 SVO0BQDL]2 YRR R- +@ =v

cuts
x D <& » 000 mm
v <& » 000 mm
z[) « [J» 000 mm
[<cutting disabled> -
[ Executect | Reset )
Information
Length: 21800 mm Voume: 23271 om
Width: 11863 mm  Area: - e1255 o
Height: m mm  Triangles: 9974

10f1 partis selected.

Upgrade now!

8. Part > Export Part > as STL

22 netfabb Basic 6.1 - DEMO Cl j B — oo WA i N e D
Project Edit Edras View Settings Help
a.‘.ﬁfm’ PROBCYL]2 yRIBR R +@ =V

Q) Remove
g
7 DEMO Cl epaired)
B Evortpan » asSTL : eanup (repaired)
% Duplicate CrleX a5 STL (ASCI) :
as color STL
L Jl s GTs
@) Change color AME
x30
9 Move CtrlsV as
Q) Rotate Ctrl+R s X3DB
1, sl . 25305
|9 Put part on platform Ctrl+Down es el
as Wavefront OB)
@ vertpor asPLY
|4 Mirror 25 VRML
o Align parts 253MF
}8 Merge selected parts (Pro) as Slice
5{ Shells to parts (Pro)
4] convertunits

cuts
x [ <& > 000 mm
v <& » 000 mm
z[) « [J» 000 mm
[<cutting disabled> -
[ Executect | Reset )
Information
Length: 21800 mm Voume: 23271 om
Width: 11863 mm  Area: - e1255 o
Height  190.37 mm Triangles: 974

10f1 partis selected.

Upgrade now!

move and rotate the selected parts by the mouse and the cursor keys.
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9. Your part is now saved as a repaired STL, and can be opened in SolidWorks. If
after selecting export this warning popup appears, click Optimize. The warning

triangle now becomes a green checkmark. Click Export.

Eeer L S| B fomom)
Some file formats do not indude enough information. This
may result in errors.
Degenerated triangles (create holes): o
Manifold edges (get spit): 1
e
=2 Export A <
No problems expected. The fles should be error-free.
Degenerated triangles (create holes): 0 J
Manifold edges (get spit): [)

Opening Part in SolidWorks:
1. Open SolidWorks

2. Open your part (filter to .STL files)
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75 soLworks [§ : ? - =@ X

. » Allie thesis work

Organize v New folder ]

3¢ Favorites “ Name Date modified Type

B Desktop | @ Cleanup 3-11-2016, 2nd half (repaired) 3/11/201612:55PM  Meshmixer Docu...
18 Downloads @ Cleanup 3-11-2016, 1st half (repaired) 3/11/201612:53PM  Meshmixer Docu...
Recent Places @ Cleanup 3-11-2016, longer daughter, full ..  3/11/201612:52PM  Meshmixer Docu..
@ Cleanup 3-11-2016, Halved (repaired) 3/11/201612:31PM  Meshmixer Docu.
4 Libraries @ cleaned up shortened, 10000faces (repair...  2/28/2016 1209 PM  Meshmixer Docu...
[ Documents @ DEMO Cleanup (repaired) 2/28/201612:07PM  Meshmixer Docu...
& Music @ DEMO Cleanup 2/28/20161200PM  Meshmixer Docu...
[ Pictures @ cleaned up shortened, 10000faces 2/19/201612:50 PM  Meshmixer Docu...
B videos @ cleanup22-19 2/19/201612:45PM  Meshmixer Docu...
@ Arch cleanup hole 2-19 2/19/201612:35PM  Meshmixer Docu..
1% Computer @ Arch cleanup 2-19 2/19/201612:32PM__ Meshmixer Docu...
£ LocalDisk(cy ¢ ]

Display States:

File name: Cleanup 3-11-2016, 2nd half (repaired) v [sTLest)

Opens an eisting document.

30 PM
3/11/2016

3. Accept the Import Diagnostics (click Yes)

‘775 SOLIDWORKS v| 0O ﬂ,,—,l >-9.- 5 -8 FE- Cleanup 3-11-2016, longer daughter, full (repaired) @ search SolidWorks Help £ +| @ ~ = BB X

o v Check 5%, Deviation Analysis 03 Draft Analysis i\ symmetry Check " p
D::I." B % I} , o o ysis 52 y: ) ST I » " %) [ 3
<tugy | Measure  Mass  Section Sensor [V Geometry Analysis | Zebra Stripes (3 Undercut Analysis 5= Thickness Analysis i) | SimulationXpress FloXpress DFMXpress DriveWorksXpress ~Costing »
o Properties Properties Statistics > | “Analysis Wizard ~ Analysis  Analysis
- (@) Import Diagnostics | [l Curvature % Parting Line Analysis T3] Compare Documents = Wizard Wizard
Features | Sketch | Evaluate [ DimXpert | Office Products | @ - G- . H - OO o

SlElR[E]e]  »

B ) Cleanup 3-11-2016, longer d
(5] History
(2] Sensors
(4] Annotations
3= Material <not specified>
% Front Plane
X Top Plane
X Right Plane
L. Origin
D STL Graphicst

SolidWorks ‘

i), Doyouwish to run Import Diagnostics on this pet?

[C] Don'tshow again

SolidWorks Education Edition - Instructional Use Only tom -~ [2] &
3 31 PM
3/11/2016
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4. The part should now be imported into SolidWorks as a solid part. The message
box on the left of the import diagnostics window should be green and read “No

faulty faces or gaps remain in the geometry.”

Click the Green Checkmark. Your part is now a solid part and can be modified using

SolidWorks.
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Appendix B: 3D Printer Basic and Advanced Settings

Minuites
[ 2172 @I
A6

Initial layer thickness (mm) 0
Initiallaver line width (%) 100
Cut off object bottom (mm) 0.0
Dual extrusion overlap (mm) 0.15
Speed

Travel speed (mm/s) 130
Bottom layer speed (mm/s) 35
Infill speed (mm/s) 0

Top/bottom speed (mm/s) 0.0
Outer shell speed (mm/s) 55
Inner shell speed (mm/s) 55

ool
Minimal layer time (sec) 5
Enable cooling fan @ =)

leuiiskolminuites
Simeteigzzelgiam!
B.21

111



Appendix C: Inlet Velocity Calculations

Average measured inlet flow rate: 13.737 seconds per liter

1 Liter 60 seconds

=4, Li ]
13.737 seconds .1 minute 367 Liters/minute

4.367 Liters 1 meter3
3
60 Seconds 10000 Liters

) =V * (1 * (0.0127 meters)?)

V = 0.1436 meters per second
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Appendix D: Imagel Processing Methods

1) Setting the image scale:

| Image) File Edit m Process Analyze Plugins Window Help
. Type > L L "
Bolaol<4] g S EAVATYPIININED S
| Show Info... 3] 1t2016-07-19 at 10.33.23 AM.ona (75%)
Properties... osep hot 2016-07-19 at 10.33.34 AM.ona (75%)

| feNaNe]
i®00 Color

Add Slice

Delete Slice

Next Slice [>]
Previous Slice [<]
Set Slice...

Hyperstacks

Crop
Duplicate...
Rename...
Scale...
Transform
Zoom
Overlay

Images to Stack
Stack to Images
Make Montage...
Reslice [/]...
Orthogonal Views
Z Project...

3D Project...

Plot Z-axis Profile
Label...

Statistics
Animation

Tools

Lookup Tables

® Image] File Edit Image Procesm Plugins Window Help ‘o O
Image]  Measure ®M ' - bt C
| Analyze Particles... B .
~ >
EL|O'G|®‘ vé_‘-‘#-,‘\|A|°\|€'7| Summarize J ‘ E
Distribution... J =~
Label S —

Clear Results
Set Measurements...

Set Scale...

Calibrate...

Histogram

Plot Profile 8K
Surface Plot...

Gels >

Tools

6 .00 Set Scale

Known distance: | 0.00

Pixel aspect ratio: | 1.0
Unit of length: | pixel

| Click to Remove Scale |
["] Global

Scale: <no scale>

Help | Cancel |
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thot 2016-07-19 at 10.33.42 AM.ona (75%)
Lo ci-snnar ae sn_iannnes AM Dng (75%)

»

e O O Set Scale

Distance in pixels: | 758
Known distance:

Pixel aspect ratio: 1.0

5.70866

Unit of length: | in

| Click to Remove Scale

(¥ Global
Scale: 132.7807 pixels/in

| Help | | Cancel

OK |




2) Adjusting image threshold and measure pixel path length from the origin:

8 Image) File Edit Process Analyze Plugins Window Help

= s . Type > L . -
(ST [RP P [R [ | I |
IE| O O] | £ pgyrrra— righiness/Contrast... 0%C

rolling tool (or press spz2  Show Info... 38l Window/Level... I

Properties... 8P Color Balance...

Color >lﬂﬂﬂﬂlllllﬂﬂ‘

Stacks > Color Threshold... |

Hyperstacks »  Size... f
Canvas Size...

Crop. THEX ' ine Width... ‘

Duplicate... %D

Rename... Auto Threshold...

Scale... #E Auto Local Threshold...

Transform >

Zoom >

Overlay >

Lookup Tables >

6
[=fe)

Image) L RON ]

=

Image) ——
‘\| A\ q|<’7\| Dey\s'k,\ 4 || e0o0 Threshold Color

Hue

z|o

£[4

Screen Shot 2016-07-14 at 12.25.47 PM.png
pixels; RGB; 909K

[?] Pass

255

Saturation

e o pass

=
145
255

Brightness
: @ -

123
255

Thresholding method: | Default &
Threshold color:| Red 3

Color space:| HSB  +|

[g Dark background

[Original | [ Filtered | [ Select | [ Sample |
| Stack | | Macro | [ Help |
@ Image) File Edit Image Process Analyze Plugins Window Help o D W 4 4) T

Stack (G) (75%)

- RE AENANLEEDHOCERE

x=833, y=208, z=0, value=153,142,143 (#998e8f)

(1636x947); RGB; 41MB__

Number

u |- V “[General
g J I/U|(S A i (B %
00 &
B [ ¢ [ b [ E ]
758 132780723
570866
3
[ 218
| 0.0330303
v e
627 155 o
606 599 ° 1

[+ Coordinates ] Trial 1 J Trial2 ] Trial 3
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3) Measuring the model’s angle of rotation:

o Image] File Edi(m Process Analyze Plugins Window Help o H M .
Type > L - g D

Image)
Adjust >
Bt IS w INAla o cofswf a2 | |»
Properties...
Color T—
Stacks
Hyperstacks m— )

Crop
Duplicate...
Rename...
Scale...
Transform

Overlay Out [-]
Original Scale 884
Lookup Tables View 100% 5
To Selection
Scale to Fit
Set...

| Image)
Kr& (Slolc|o| <J& +[ A a|o|@F] s 4]a]~]

- ngle tool

8 00 T1 F58.PNG (200%)
pixels; RGB; 5.9MB

® Image) File Edit Image Process JNFIZTY Plugins Window Help o O = . .

| Stack (©) 7O ST, O image)
(1636x947). RCB. 41MB_ Analyze Particles... Doz 4]+ Ala|o|F

Summarize
Distribution...

Label

Clear Results

Set Measurements...

Set Scale...

Calibrate...
Histogram
Plot Profile
Surface Plot...
Cels

Tools
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Appendix E: Example Images of Dye Trial 1

Raw Images:

18F

Trial 1, Frame 18
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Trial 1, Frame 38
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Trial 1, Frame 58
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EE

Trial 1, Frame 68

Images with threshold from ImageJ:

Trial 1, Frame 8, Threshold
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Trial 1, Frame 28, Threshold
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BF

Trial 1, Frame 38, Threshold

Trial 1, Frame 48, Threshold
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88F

Trial 1, Frame 68, Threshold
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